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CE Mark

The CE marking applied to this product symbolises Rank Xerox’s declaration of conformity with the following applicable directives of the European Union as of 
the dates indicated.

January 1, 1996—Council Directive 70/80/CCO amended by Council Directive 93/68/EEO. Approximation of the laws of the member states related to low 
voltage equipment.

January 1, 1996—Council Directive 59/336/EEC. Approximation of the laws of the member states related to electromagnetic compatibility.

A full declaration defining the relevant directives and referenced standards can be obtained from your Rank Xerox representative.

WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from 
ISM equipment may have to be limited or special migration measures taken.

WARNING: This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to 
take adequate measures.

FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, 
and uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

Industry Canada Class A Notice

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard 
entitled, “Digital Apparatus” ICES-003 from Industry Canada.

Avis de Conformation Classe A d l’Industrie Canada 

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe A prescrites dans la 
norme sur le matériel brouilleur, “Appareils Numériques” NMB-003 édictée par l’Industrie Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
Electronics for Imaging, Inc.

Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.



             
Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen ist 
der Betreiber verantwortlich.

Software License Agreement

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the Fiery SI Color Server you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with Fiery SI;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery SI in a special encrypted format (“Coded Font 
Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own customary 
business purposes on the screen of the Fiery SI or Macintosh monitor used with Fiery SI;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery SI provided the transferee agrees to be bound by all 
of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 
for use other than with Fiery SI;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the Fiery SI unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of that certain portion of the Software which has been included on the Fiery SI hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font Programs. 
At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

The MacApp software is proprietary to Apple Computer, Inc. and is licensed to Electronics for Imaging, Inc. for distribution only for use in combination with 
Fiery SI software utilities.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
Fiery SI to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct 
or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states 
do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.



           
Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF FIERY SI XJ REFLECTS THIS ALLOCATION OF RISK. 
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 303 Almaden Blvd., San Jose, CA  95110 (“Adobe”) is a third-party 
beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the Typefaces 
and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics for 
Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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xi How the Fiery SI works

   
The Fiery SI Color Server enables you to use your color copier as a networked printer 
and scanner. You can use the Fiery SI to print final documents or to proof jobs you will 
later print on an offset press. You can print to the Fiery SI as you would print to a 
LaserWriter or other printer—you select it from the Macintosh Chooser or Windows 
Printers dialog box, and then print from within any application.

You can print to the Fiery SI from networked Apple Macintosh computers, from 
networked IBM PC or compatible computers running Microsoft Windows, and from 
networked UNIX workstations running TCP/IP. In addition, you can use the parallel 
port to print directly from a PC.

How the Fiery SI works
The Fiery SI is a special-purpose controller that enables you to use a color copier as a 
printer by connecting it to networked computers. It also enables you to scan a 
document from the copier and work with the scanned image on your computer.

The Fiery SI receives files from computers on your network, processes (RIPs) those 
files, and then sends them to the copier’s print engine for printing. Even with the 
Fiery SI installed, you can still use your copier to make copies.

Macintosh and PC computers communicate with the Fiery SI by means of a Printer 
Driver application. Printer description files enable you to use special features of the 
Fiery SI from the Print dialog box.

Before You 
Begin
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About the documentation
This guide is part of the set of Fiery SI documentation that also includes the following 
manuals for users and system administrators:

• Getting Started describes how to install the software from the User Software CD or 
from floppy disks and how to set up printing.

• The Administrator Guide explains basic configuration and administration of the 
Fiery SI for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT, and NetWare servers to provide 
PostScript printing services to clients.

• Release Notes include information about changes in the current release of system and 
user software, last-minute information, and information to help you use them 
efficiently.

Using this manual
This manual includes the following topics:

• Printing from a Macintosh

• Printing from a Windows PC

• Scanning jobs from a Macintosh or Windows PC

• Using the Macintosh and Windows Downloader and Spooler

• Calibrating the Fiery SI

• Printing from UNIX

• Appendixes—Includes a list of Fiery SI error messages, examples of the printer fonts 
installed on the Fiery SI, troubleshooting information, information about setting 
and overriding job settings.

World Wide Web
You can visit the Electronics for Imaging World Wide Web page to download the latest 
information and software. In addition, the WWW page contains marketing and 
corporate information about Electronics for Imaging. The address is:
http://www.efi.com
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Safety warnings
The Fiery SI display window is a liquid crystal display (LCD) that is made of glass and 
can break. Do not subject it to strong shocks.

If the display window breaks and the liquid crystal material leaks out, do not inhale, 
ingest, or touch it. If the material gets on your skin or clothing, wash it off with soap 
and water immediately.

Do not touch or put pressure on the panel. This will change the color of the panel.

Cleaning the Fiery SI
Clean the Fiery SI with a soft cloth moistened with isopropyl alcohol or ethyl alcohol. 
Never use water or ketone as these may permanently alter the display.

System requirements for Macintosh users
For installation of user software, you need A CD-ROM drive. This can be either an 
internal CD-ROM drive in your Macintosh or an external drive with the appropriate 
cable and software to run on your computer.

To use the Fiery SI with a Macintosh computer, you need:

• Any Macintosh computer in the Macintosh II, Quadra, Centris, Performa, or Power 
Macintosh families that has at least 4MB of RAM and EtherTalk® Phase 2 installed

• Apple System software version 7.0 or later

• Adobe® PostScript® Printer Driver version 8.0 or later, or Apple® LaserWriter® 
driver version 7.0 or later; and PPD (PostScript Printer Description) files 

(The current version of the Adobe PostScript Printer Driver and the PPD files are 
included with the Fiery SI User Software.)

• To use Fiery XJ Scan™, Adobe Photoshop™ version 2.5 or later

• To use the paging feature of Fiery XJ Spooler, an alphanumeric pager and 
PageNOW! software version 1.5 or later. PageNOW! is available from Mark/Space 
Softworks: 1-800-799-1718. (United States and Canada only)
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System requirements for Windows users
For installation of user software, you need A CD-ROM drive. This can be either an 
internal CD-ROM drive in your PC or an external drive with the appropriate cable 
and software to run on your computer.

To use the Fiery SI with an IBM PC or compatible, you need:

• An IBM PC or compatible with an 80386, 80486, or Pentium processor and at least 
4MB of RAM

• A mouse that is supported by Windows

• MS-DOS version 5.0 or later

• Microsoft® Windows version 3.1 or later, Windows 95, or Windows NT

• To use Fiery XJ Scan, Adobe Photoshop version 2.5 or later

• To print to the Fiery SI from Windows, you need to use a PostScript printer driver 
and PostScript Printer Description (PPD) file. These drivers and PPD files are 
included with the User Software. Use the Adobe PostScript Printer Driver for 
Windows version 3.0.1 with Windows 3.1x. Use version 4.1 with Windows 95. 

Windows 3.1x users can use the PostScript Printer Driver that came with the 
Windows3.1 system software; however, all Fiery SI printing features will not be 
available.

• To print from computers running Windows NT, you can use the PostScript driver 
delivered with the operating system, and the Fiery SI PPD file provided with the 
User Software.

Networking requirements
For network use with Windows 3.x, you need

• Farallon PhoneNET PC software version 3.1 or later (for AppleTalk) or 
COPSTalk for Windows version 1.2f or later (for AppleTalk); or 
SPX/IPX protocol (Novell), Ethernet, or Token Ring

For network use with Windows 95, you need 

• TCP/IP networking protocol or
SPX/IPX networking protocol (Novell) 

For network use with Windows NT, you need TCP/IP networking protocol 
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IPX (Novell)

• With an IPX (Novell) network, you need a Novell file server running NetWare 
software version 3.11 or later that supports Frame Ethernet 802.3 or 802.2, or 
Ethernet II.

System requirements for UNIX users
To use the Fiery SI with a UNIX workstation, you need:

• Workstations with Standard TCP/IP Ethernet connectivity supporting the lpr 
protocol in compliance with RFC 1179

• TCP/IP printing software that conforms to RFC1179 (Berkeley lpr protocol) 

Specifications
The Fiery SI has the following features:

• 32MB RAM

• CPU R4600/R4700, 100 MHz

• Supports AppleTalk, TCP/IP, and IPX protocols simultaneously

• Supports EtherTalk Phase 2

• Supports thinnet (by transceiver), thicknet, and twisted pair cabling

• Supports token ring networking with additional optional hardware

• Supports Adobe PostScript Level 2 CPSI

• Includes 39 PostScript fonts

You can use the Fiery XJ Downloader or any third-party LaserWriter downloader, 
such as the Adobe Font Downloader, to download additional fonts

• Built-in EFICOLOR color management

• Internal 2.1GB hard disk drive.

• For installation of Fiery SI system software—CD-ROM drive and 50-pin SCSI 
cable to connect the drive to the Fiery SI’s SCSI port
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Supported paper sizes
The Fiery SI supports the following paper sizes:

• Letter, Letter SEF

• A4, A4SEF 

• 8” x 10”

• 9” x 12”

• Legal (216mm x 356mm)

• Legal 13 (216 x 330mm)

• Tabloid (11” x 17”)

• A3 

• Postcard

• The 5750 also supports A6SEF and 12” x 18” paper sizes.

Resolution
The Fiery SI prints at 400 dots per inch (dpi) on all supported paper sizes.

The Fiery SI scans at a maximum resolution that is dependent on the size of the 
scanned area. For letter or A4 paper sizes, the maximum scan resolution is 200 dpi. For 
an area that is roughly one-fourth the size of letter/A4, the maximum scan resolution is 
400 dpi.
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1-1 Using the Control Panel

     
You can use the Fiery SI control panel to view status information about jobs, print 
special pages, and set up printing. For information about Setup options and how to use 
them, see the Administrator Guide.

Using the Control Panel
The Control Panel on the front of the Fiery SI enables you to access special features 
and view information about jobs printed to the Fiery SI. 

It comprises the following parts:

• Activity light that indicates current Fiery SI activity

• Line selection buttons

• Up and down arrow buttons

• Menu button

• Display window showing status information and options for setting up the Fiery SI

Chapter 1:
Operating the 
Fiery SI

Activity light 

Menu button

Display window

Up and down arrow buttons

Line selection buttons
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1-2 Operating the Fiery SI

      
Activity light
The activity light indicates the current Fiery SI activity. If the light is:

Buttons

Solid red There is an error causing printing and scanning to be 
disabled, and the Fiery SI is idle.

Flashing red There is an error causing printing and scanning to be 
disabled, but the Fiery SI is still processing. The light 
changes to solid red when it is finished processing.

Solid green The Fiery SI is idle.

Flashing green The Fiery SI is processing or printing a job, or 
communicating with a remote computer—for example, 
through the Fiery XJ Spooler.

No light The Fiery SI is off or starting up.

Line selection 
buttons

There are four line selection buttons on the right side of the 
Control Panel. Use these buttons to select the command 
displayed on the corresponding line of the display window. A 
special character (>) appears in the display window next to a 
button when it is active.

Up/down 
arrow buttons

Use these buttons to scroll to different screens in 
multi-screen lists, to select Setup options from a list of 
available options, and to select alphanumeric characters. 

Menu button Press this button to view other screens. Under normal 
operation, the Control Panel displays the Info Status screen 
with information about the status of the Fiery SI. If you press 
the Menu button, the Functions menu is displayed and you 
can perform additional operations. If a job is processing or 
printing, press the Menu button to display the RIP Status 
screen or Print Status screen.



 

11-3 Using the Control Panel
Display window
The display window provides information about the status of the Fiery SI, displays 
menu information, and enables you to view and edit information in the Setup menus. 

The last line of the display window displays text that tells you what screen you are 
looking at and highlights one of the icons to indicate what the Fiery SI is doing. Only 
the icons for the screens that are currently available appear.

The screens are:

Alert Status If there is a problem with processing a job or printing functions, 
an error message appears on the Control Panel. For information 
on error messages, see Appendix A “Error Messages.” 

Print Status When the Fiery SI is printing or scanning a job, the Print Status 
screen appears. This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job 
currently printing. 

User name—The name of the user who sent the job currently 
processing.

Pages/Total—The number of copies of the current page printed 
and the total number of copies of the page requested.
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RIP Status When the Fiery SI is processing a job, the RIP Status screen 
appears. This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job 
currently processing. The Fiery SI cancels the job before printing 
begins.

Document name—The name of the document currently 
processing.

User name—The name of the user who sent the job currently 
processing.

Kilobytes—The amount (in kilobytes) of the job processed so 
far.

Info Status When the Fiery SI is not processing or printing a job, it displays 
information about the current server and software. It displays the 
following information:

Server Name—The Fiery SI name.

Status—The current status of the Fiery SI. The Fiery SI status 
can be: Idle, Initializing, Busy, Processing, Printing, or Scanning.

Number of MB—The space (in megabytes) available on the 
Fiery SI hard disk.

Version—The system software version running on the Fiery SI.

Functions You can press the Menu button to display the Functions menu. 
Use the up and down arrow buttons to scroll through the list. 
Press the line selection button to the right of the command to 
select it. 
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Functions menu

You can choose the following commands from this menu:

Choose: To do this:

Print Pages Print special pages from the Fiery SI. You can print the 
following pages from the submenu that appears:

Test Page—A test page enables you to confirm that the 
Fiery SI is properly connected to the copier and provides 
color and grayscale samples to troubleshoot problems with 
the copier or the Fiery SI. The following information is 
listed: Server Name, Printer Model, Color Mode, 
Calibration, Target, Color Rendering , and Date and Time 
printed.

Configuration—Prints the Configuration page, which 
gives the current server and device configuration. This 
page lists general information about the hardware and 
software configuration of the Fiery SI, the current options 
for all Setup settings, information about the current 
calibration, and the ethernet and token ring addresses (if 
applicable) of the Fiery SI. 

Job Log—Prints a log of the last 55 jobs. For information 
on the fields in the Job Log and on printing it in other 
forms, see “Using the Job Log” on page 5-22.

Control Panel Map—Prints the Control Panel Map, which 
is an overview of the screens you can access from the 
Control Panel. For information about using these screens 
to set up the Fiery SI, see the Administrator Guide.

Color Charts—Prints samples of the RGB, CMY, and 
PANTONE colors available from the Fiery SI. 

Font List—Prints a list of all fonts resident on the hard 
disk.
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Suspend Printing Suspend communication between the Fiery SI and the 
copier. You can suspend printing if you want to interrupt 
the current Fiery SI job so that you can use the copier to 
make copies. Jobs continue to process on the Fiery SI and 
after you make the copies, you can select Resume Printing 
and the copier will continue printing jobs. 

Resume Printing Resume communication between the copier and the 
Fiery SI after you have finished making copies. 

Run Diagnostics This command is provided for service representatives. Use 
the line selection buttons to select the diagnostic test you 
want to run and choose OK. Contact your authorized 
service/support technician for information about these 
diagnostics.

Reboot Server Shut down all Fiery SI activity in the correct manner and 
then restart. You should use this option instead of the 
switch on the rear of the Fiery SI.
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Starting and shutting down the Fiery SI
Generally, you can leave the Fiery SI running all the time. This section describes how 
to shut down and restart the Fiery SI when necessary.

Starting the Fiery SI
To start the Fiery SI, move the switch on the rear of the Fiery SI to the On position.

Diagnostic messages appear on the Control Panel. If any diagnostics fail, more 
information and instructions appear. Contact your service representative if the Fiery SI 
encounters problems while running the diagnostics.

When the diagnostics are finished, the following message is displayed:

For software update or setup press any key

If you want to change the Setup options, press one of the buttons; if you do not press a 
button, the Fiery SI continues starting up and displays the message Idle when it is 
ready to receive data.

Power switch in the 
off position
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If you press a button, the following options appear:

Restarting the Fiery SI
You should use the procedure described in this section to restart the Fiery SI rather 
than using the power switch on the rear of the Fiery SI. 

TO RESTART THE FIERY SI:

1. Make sure that the Fiery SI is not receiving, processing, or printing a document. 

Make sure that the status message on the Control Panel is Idle.

NOTE: If a job from the Print Queue is processing, it will continue processing and print 
after the Fiery SI is restarted; if a job sent to the direct connection is processing, it will 
not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Use the down arrow button to scroll to the last screen and choose Reboot Server.

Choose: To do this:

Run Setup View the options in the Setup menus. For information on 
these settings, see the Administrator Guide.

Install Software Install new system software. This should be done only by 
your Fiery SI service representative.

Format Disk Reformat the Fiery SI hard disk. This should be done only 
by your Fiery SI service representative.
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Shutting down the Fiery SI
You may need to shut down the Fiery SI for service. When you do so, fonts that have 
been downloaded to the hard disk drive are not deleted. Print jobs in the Hold and 
Printed queues and jobs that have been processed but not printed are not deleted and 
are available for printing when you restart the Fiery SI.

TO SHUT DOWN THE FIERY SI:

1. Make sure that the Fiery SI is not receiving, processing, or printing a document. 

Make sure that the status message on the Control Panel is Idle.

NOTE: If a job from the Print Queue is processing, it will continue processing and print 
after the Fiery SI is restarted; if a job to the direct connection is processing, it will not 
finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Scroll to the final screen and select Reboot Server.

You should always select Reboot Server before you turn the Fiery SI off to ensure that 
no jobs are lost.

4. Switch off the Fiery SI when it restarts.
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2-1 Printing from applications

 

You can print to the Fiery SI just as you would print to a LaserWriter or other printer. 
First, select the Fiery SI as the current printer in the Chooser, then print the file from 
within your application. Depending on the application and printer driver you are 
using, you may need to use the Page Setup dialog box to set printing options after you 
select the Fiery SI in the Chooser. 

 

Printing from applications

 

You can print to the Fiery SI from applications by selecting a Fiery SI in the Chooser. 
If you have installed the Adobe PostScript Printer Driver 8.0 or later or the LaserWriter 
Printer Driver version 8.0 or later, you can override some of the printer settings on the 
Fiery SI in the Print Options dialog box.

 

T

 

O

 

 

 

SELECT

 

 

 

THE

 

 F

 

IERY 

 

SI 

 

AS

 

 

 

THE

 

 

 

CURRENT

 

 

 

PRINTER

 

:

 

1. Make sure that the Fiery SI is connected to your network and turned on.

2. Select Chooser from the Apple menu.

3. Click the PSPrinter icon or the LaserWriter icon to select it.

 

Select PSPrinter if you are using the Adobe PostScript Printer Driver; select 
LaserWriter if you are using the LaserWriter Printer Driver.

 

4. If your network is divided into zones, select the zone in which the Fiery SI is located.

5. Select the Fiery SI in the list that appears.

 

The names of all supported printers in the zone appear in the Chooser window.

 

N

 

OTE

 

:

 

If your system administrator disabled the connection to one of the queues or the 
direct connection, the corresponding name will 

 

not

 

 appear in this list.

 

6. Make sure that AppleTalk is Active, set Background Printing to Off, and then click the 
close box to quit the Chooser.

 

The Fiery SI is selected as the current printer until you choose a new printer in the 
Chooser.
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T

 

O

 

 

 

PRINT

 

 

 

FROM

 

 

 

A

 

 M

 

ACINTOSH

 

 

 

APPLICATION

 

:

 

1. Make sure that any printer description files needed by the application are installed on 
your Macintosh.

 

See 

 

Getting Started 

 

for information on which files you need and where to install them.

 

2. Open the file you want to print from within the application.

3. Choose Page Setup from the application’s File menu.

4. Select printing options in the Page Setup dialog box and click OK.

 

If you are using the LaserWriter printer driver and the Page Setup dialog box lets you 
select from a pop-up menu of available printers, choose the Fiery SI.

 

N

 

OTE

 

:

 

The 

 

Text Smoothing, Graphics Smoothing

 

, and 

 

Faster Bitmap Printing

 

 
options have no effect on files printed with the Fiery SI.

 

5. Choose Print from the application’s File menu.

6. Select the settings you want.

N

 

OTE

 

:

 

Print dialog boxes vary across applications and printer drivers.

If you can select a 

 

Paper Source

 

, specify the paper tray to use for the job. For example, 
you can specify that the job should be printed on the paper or transparencies in the 

 

bypass tray

 

.

Make sure that a color option is selected; otherwise, your color file may print in black 
and white. 
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If you are using the Adobe PostScript Printer Driver version 8.3, you can enter notes in 
the 

 

Note 1:

 

 and 

 

Note 2:

 

 area at the bottom of the dialog box. These notes will appear 
in columns in the Job Log.

If the Print dialog box lets you select from a pop-up menu of available printers, choose 
the Fiery SI. 

 

7. Click Options to specify additional information for the print job.

N

 

OTE

 

:

 

The LaserWriter Printer Driver and the Adobe PostScript Printer Driver 
version 8.3 may show different options. See your documentation for information. 

Selecting 

 

ColorSync Color Matching

 

, activates the ColorSync ICC profiles. If you 
choose this option, be sure to select the 

 

Printer Profile

 

 that corresponds to your copier. 
Selecting 

 

PostScript Color Matching

 

 activates color rendering dictionaries. If you use 
this option, leave the 

 

Printer Profile

 

 option as 

 

Printer’s Default

 

. Then select a CRD 
from the 

 

Rendering Styles

 

 pop-up menu in the lower part of the window.

Options in the lower portion of this dialog box are specific to the Fiery SI. They 
override settings in the Printer Setup on the Fiery SI. (You must scroll to see all the 
pop-up menus.)

You can override some of these settings in the Fiery XJ Spooler Override Print Settings 
dialog box. 

If you choose 

 

Printer’s default

 

, the Fiery SI prints according to the setup options 
entered on the Control Panel. 

 

N

 

OTE

 

:

 

Photoshop RGB images saved in EPS format may activate color rendering 
dictionaries even if the 

 

Color/Grayscale

 

 option is selected.
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8. Click 

 

Save

 

 after you change the options to make the new settings your default 
settings.

 

For information about these options, see Appendix D "Setting Job Overrides."

 

9. Click OK to accept your options, and click Print to print.

 

Printing pages from the bypass tray

 

You can use the Fiery SI to print manually fed pages on the copier if you want to print 
on special paper or transparencies. You can use the Fiery SI to print on 16–24 pound 
paper (60–90 gsm), thick paper (28–32 pound/105–120 gsm) or Xerox-recommended 
transparencies from the bypass tray. You can also use the bypass tray for paper sizes 
such as A6 and 11” x 18” (model 5750 only). 

There are several ways to print manually fed pages:

• From the Control Panel, you can set 

 

Enable Bypass Tray as default

 

 to 

 

Yes

 

 to print all 
jobs from the Bypass Tray unless another tray is specified.

• From within the Fiery XJ Spooler, select a job, choose 

 

Override Print Settings

 

 and 
set the 

 

Bypass Tray

 

 option to 

 

On

 

.

• For many applications, you can use the following procedure and choose 

 

Bypass Tray

 

 
in the Print or Page Setup dialog box.

 

T

 

O

 

 

 

PRINT

 

 

 

PAGES

 

 

 

USING

 

 

 

THE

 

 

 

BYPASS

 

 

 

TRAY

 

: 

 

1. Make sure that the Use Bypass Tray option on the copier panel is set to No.

N

 

OTE

 

:

 

If you select 

 

Bypass

 

 as your paper supply on the copier, the copier will be in 
Copier Mode and unavailable for printing. 

 

2. Load paper or transparencies into the bypass tray.

 

You can load up to 40 sheets.

 

3. Press the Clear All button on the copier.
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4. From your application, choose Bypass Tray as the Paper Source in the Page Setup or 
Print dialog box.

 

If 

 

Interleaved

 

 mode is chosen in the Print Options dialog box, one of the paper trays 
must be loaded with a paper the same size and orientation as the transparencies in the 
bypass tray.

 

5. Select the correct page size in the Page Setup or Print dialog box.

6. Click Print in your application.

 

Using the color reference pages

 

The Fiery SI User Software includes several types of color reference pages that you can 
view and print to see the full range of colors available from your Fiery SI.

• The CMYK Color Reference pages enable you to view and print CMYK color 
patches in the range of colors the Fiery SI can print. 

• Color Charts is a downloadable PostScript file of the Color Charts that can be 
printed from the Control Panel.

• The RGB Color Reference pages are a Microsoft Word and a Microsoft PowerPoint 
file that you can open in the application to view the colors available in the standard 
palette for that application and see how they print on the Fiery SI.

• The PANTONE books are downloadable PostScript files that simulate all of the 
PANTONE colors available from your Fiery SI.

The CMYK Color Reference PostScript file and the PANTONE books are installed 
with the installer. The other color reference pages are in the Color Files folder on your 
User Software CD. You can install them individually as needed as described in 

 

Getting 
Started

 

.

 

N

 

OTE

 

:

 

When you print these files, you can try different color rendering styles to find 
the best results for your needs.
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CMYK Color Reference pages

 

The Color Reference folder contains a PostScript file of color reference pages that you 
can download to the Fiery SI. You can use the pages as a reference for graphics 
applications that allow you to specify color as values of cyan, magenta, yellow, and 
black. The pages display groups of color patches and give you the percentage of each 
process color required to achieve the color shown. There are 11 pages—each one shows 
colors from 0% to 100%.

 

T

 

O

 

 

 

PRINT

 

 

 

AND

 

 

 

USE THE CMYK COLOR REFERENCE PAGES:

1. Use the Fiery XJ Downloader to download the CMYK Reference.ps file.

For information on using the Fiery XJ Downloader, see “Downloading files and fonts” 
on page 5-1.

2. Select the color that you want to use from the color reference page.

3. Enter the corresponding cyan, magenta, yellow, and black values in any application 
that supports CMYK.

Color Charts 
The color charts are a PostScript version of the color charts you can also print from the 
Control Panel. They are designed to look best when the copier is calibrated to the 
copier standard and not one of the press standards.

TO PRINT AND USE THE COLOR CHARTS:

• Use the Fiery XJ Downloader to download the Colorchart.ps file in the Color Charts 
folder from the Color Files folder on the User Software CD or Floppy Disks.

For information on using the Fiery XJ Downloader, see “Downloading files and fonts” 
on page 5-1.
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RGB Color Reference pages
The application pages display the RGB colors available in Microsoft Word and 
PowerPoint.

TO PRINT AND USE THE RGB COLOR REFERENCE PAGES:

1. Open Microsoft Word 6.0 or later or PowerPoint 4.0 or later.

2. Open the RGB page 01 (Word) or RGB page 02 (PowerPoint) file in the Color 
Files:Application pages:RGB Color Reference folder from the Color Files User Software 
CD or floppy disk.

3. Choose Print from the File menu.

4. Select the color that you want to use and enter the corresponding values for colors you 
want to reproduce in your own Word or PowerPoint document.

PANTONE books
The PANTONE book files print standard PANTONE colors as they appear when 
printed on a Fiery SI. There are PANTONE books that simulate coated and uncoated 
paper stock for all supported devices.

TO PRINT AND USE THE PANTONE BOOKS:

1. Use the Fiery XJ Downloader to download the Coated or Uncoated PostScript file that 
corresponds to your device.

These files are installed in the Color Reference folder by the installer. For information 
on using the Fiery XJ Downloader, see “Downloading files and fonts” on page 5-1.

2. Enter the PANTONE color number in an application that supports specifying colors that 
way.
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3-1 Printing to the Fiery SI

 

The Fiery SI enables you to print from an IBM PC-compatible computer connected to 
the Fiery SI. This section describes how to print to the Fiery SI from Windows.

For information on setting up the Windows environment for printing with Windows 
servers connected to the Fiery SI, see the 

 

Administrator Guide

 

. For information on how 
to connect to the Fiery SI over the network, install printer drivers, and install the 
Fiery SI utilities, see 

 

Getting Started

 

.

 

Printing to the Fiery SI

 

You can print files directly to the Fiery SI from within your Windows application. If 
you plan to print files at another location, you should follow the procedures described 
in “Saving files to print at a remote location.” You can print from a PC connected to 
the parallel port on the Fiery SI. This PC can also be a Novell server.

 

Printing from applications

 

Once you have installed the Fiery SI printer driver and set it to the proper port as 
described in 

 

Getting Started

 

, you should be able to print directly from most Windows 
applications. Simply choose the Print command from within your application.

 

Saving files to print at a remote location

 

If you do not have a Fiery SI and are preparing files to take to a service bureau or other 
location, you should print your final files to the File port. You can also print to the File 
port to create a file to be downloaded with the Fiery XJ Downloader.

 

Printing to the parallel port

 

The Fiery SI has a parallel port that enables you to print most files directly from a PC 
if your network administrator has connected the PC’s parallel port to the Fiery SI 
parallel port. 

 

N

 

OTE

 

:

 

You cannot use the Fiery SI utilities through the parallel port.

Chapter 3:
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T

 

O

 

 

 

PRINT

 

 

 

FILES

 

 

 

WITH

 

 

 

THE

 

 

 

PARALLEL

 

 

 

PORT

 

:

 

1. Make sure that parallel printing is enabled on your Fiery SI.

 

Print the Configuration page to see if parallel port printing is enabled. See the 

 

Administrator Guide

 

 for information about setting up parallel printing on the 
Fiery SI and 

 

Getting Started

 

 for information about setting up parallel port printing on 
your PC.

 

2. Select the printer port that is connected to the Fiery SI’s parallel port.

 

Select one of the local ports: 

 

LPT1, LPT2, 

 

or

 

 LPT3

 

. For instructions, see your 
Windows documentation. 

 

3. Print from within your application.

 

If you are printing a PostScript file in binary format (not ASCII), verify that the 
Network Setup option 

 

Ignore EOF

 

 

 

character

 

 is set to 

 

Yes

 

. You can use the Functions 
menu on the Fiery SI to print the Configuration page to view the settings for all Setup 
options.

 

Setting printing options

 

Once you have installed the Fiery SI printer driver file, you can select the printer 
settings you prefer. You can also change some of these settings for a particular file from 
within your application when you send the file to the Fiery SI. 

 

Printing with Windows 3.x

 

You can use the Fiery SI with either the Adobe PostScript Printer Driver 
(ADOBEPS.DRV) included with the Fiery SI or the Windows PostScript Printer 
Driver (PSCRIPT.DRV) included with your Windows software.

 

Printing with Windows 95

 

To print from Windows 95 applications over a network, you must be connected to a 
print server. This can be a Novell NetWare server, NT server, or UNIX server. See the 

 

Administrator Guide

 

 for information about connecting a server to the Fiery SI.

You can print from Windows 95 with the Adobe PostScript Printer Driver for 
Windows version 4.1. 
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Printing with Windows NT

 

You can print from Windows NT with the Printer Driver included with Windows NT. 
It does not support additional PostScript Level 2 features, so you cannot set any 
Fiery SI-specific options. See 

 

Getting Started

 

 for information about the Windows NT 
Printer Driver.

 

T

 

O

 

 

 

CHANGE

 

 

 

THE

 

 

 

PRINTER

 

 

 

SETUP

 

 

 

WITH

 

 

 

THE

 

 A

 

DOBE

 

 P

 

OST

 

S

 

CRIPT

 

 P

 

RINTER

 

 
D

 

RIVER

 

 

 

WITH

 

 W

 

INDOWS

 

 3.

 

X

 

:

 

1. For Windows 3.x, in the Main group, double-click the Control Panel icon.

2. Double-click the Printers icon.

3. For Windows 3.x, in the Printers dialog box, select the Fiery SI in the Installed Printers 
box. Then click the Setup button.

4. Select the paper size and paper orientation in the Paper dialog box.

 

If you can select a 

 

Paper Source

 

, specify the paper tray to use for the job. For example, 
you can use this dialog box to specify that the job should be printed on the pages in the 

 

bypass tray

 

.

 

5. Click the PostScript tab.
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6. Select the appropriate information for your file and click OK.

 

Select 

 

Use PostScript Level 2 Features, Send Full Color Data, Match Color Across 
Printers, Margins: Default, Protocol Options: Default, 

 

and

 

 PostScript Performance: 
Optimize for Speed

 

.

 

N

 

OTE

 

:

 

Setting 

 

Match Color Across Printers 

 

activates the color rendering dictionaries.
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7. Click the Features tab to display the Features window, select the appropriate settings, 
and then click OK.

 

The options in this window are specific to the Fiery SI. (You must scroll to see all the 
pop-up menus.)

The settings you select in the Paper, Features, and PostScript windows override the 
settings specified in Printer Setup on the Fiery SI. You can override some of these 
settings in the Fiery XJ Spooler Override Print Settings window. 

If you choose 

 

Printer’s default

 

 for any of the options in the Features dialog box, the 
Fiery SI prints with the default value for the server, or the information entered during 
Control Panel Setup. For information about these options, see Appendix D "Setting 
Job Overrides." 
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T

 

O

 

 

 

PRINT

 

 

 

WITH

 

 

 

THE

 

 A

 

DOBE

 

 P

 

OST

 

S

 

CRIPT

 

 P

 

RINTER

 

 D

 

RIVER

 

 

 

WITH

 

 
W

 

INDOWS

 

 3.

 

X

 

 

 

OR

 

 W

 

INDOWS

 

 95:

 

1. Choose Print in your application.

 

The Color Printer Job Notes dialog box appears.

 

2. Enter your User and Document name and any notes in the Note 1 and Note 2 boxes. 

 

This information will appear in the Job Log.

 

N

 

OTE

 

:

 

If you are using Windows 95, you do not have to enter the User and Document 
information.

 

TO CHANGE THE PRINTER SETUP WITH THE WINDOWS 3.X POSTSCRIPT 
PRINTER DRIVER:

1. In the Printers dialog box, select the Fiery SI in the Installed Printers list box and click 
Setup.
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2. Use the Print Setup dialog box to specify information about the printer setup such as 
the paper size and paper orientation.

NOTE: Print Setup dialog boxes vary across applications. 

3. Click Options in the Print Setup dialog box.

Do not use the Encapsulated PostScript File option when you are printing to the 
Fiery SI. This option is for files you wish to import into other applications.

Make sure that the Color checkbox is selected.

Make sure that the Send Header with Each Job checkbox is selected. This option 
ensures that all the correct PostScript information is sent to the Fiery SI.

Select the Default option under Margins for best printing results.

You can change the size of the image by changing the Scaling factor in this dialog box, 
or you can control the image size from within your application.
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4. Click Advanced to set additional options.

The Advanced Options dialog box appears. This dialog box allows you to set advanced 
printing options. 

You can use this dialog box to choose how to send TrueType fonts to the 
Fiery SI. In most cases, you should set the Send to Printer option to Adobe Type 1, 
and you should not use the Use Substitution Table option. Click Help for more 
information about TrueType conversion options.

The Resolution box displays only the option of 400 dpi because the Fiery SI is a 400 
dpi printer. Halftone settings have no effect on the output. Selecting Negative Image 
changes black to white, blue to yellow, red to green, etc. This option may not have an 
effect in all applications. The effect of selecting All Colors to Black varies from one 
application to another. In some applications this option has no effect. Selecting Mirror 
prints a mirror image of the original. The Conform to Adobe Document Structuring 
Convention option should be off. Special effects created with some applications will 
not print if this option is selected.

5. Click OK.

6. When you have set the printing options, close all the dialog boxes.
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TO CHANGE THE PRINTER SETUP WITH THE WINDOWS 95 PRINTER 
DRIVER:

1. Double-click the My Computer icon.

2. Double-click the Printers icon.

3. Select the icon for your Fiery SI.

4. Choose Properties from the File menu.



33-10 Printing with PC-Compatible Computers

5. Click the Paper tab and enter information about the paper size and paper orientation.
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6. Click the Device Options tab and select the appropriate settings.

The options in this window are specific to the Fiery SI. For information about these 
options, see Appendix D "Setting Job Overrides." (You must scroll to see all the pop-
up menus.)

The settings you select in the Device Options window override the settings specified in 
Printer Setup on the Fiery SI. You can override some of these settings in the Fiery XJ 
Spooler Override Print Settings window. 

If you select Printer’s default, the Fiery SI prints according to the setup options 
entered on the Control Panel
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7. Click the Graphics tab.
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8. Under Color Control, click image color matching (slower) and then click Choose image 
color matching method.

9. Click to choose a color matching option. 

Choose Download image color matching. 

If you have installed a color profile and your application is ICM-aware, choosing this 
option activitates the color rendering dictionaries (CRDs) and allows you to take 
advantage of PostScript Level 2 features.

10. Close the printer window.
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Printing pages from the bypass tray
You can use the Fiery SI to print manually fed pages on the copier if you want to print 
on a special paper or a transparency. You can use the Fiery SI to print on 16–24 pound 
paper (60–90 gsm), thick paper (28–32 pound/105–120 gsm) or Xerox-recommended 
transparencies from the bypass tray. You can also use the bypass tray for paper sizes 
such as A6 and 11" x 18" (model 5750 only). 

There are several ways to print manually fed pages:

• From the Control Panel, you can set Enable Bypass Tray as default to Yes to print all 
jobs from the Bypass Tray unless another tray is specified.

• From within the Fiery XJ Spooler, select a job, select Override Print Settings and set 
the Bypass Tray option to On.

• For many applications, you can use the following procedure and select Bypass Tray 
in the Print or Page Setup dialog box.

TO PRINT PAGES USING THE BYPASS TRAY: 

1. Make sure that the Use Bypass Tray option on the copier panel is set to No.

NOTE: If you select Bypass as your paper supply on the copier, it will put the copier in 
Copier Mode and the copier will be unavailable for printing. 

2. Insert the paper or transparencies in the bypass tray.

You can load up to 40 sheets.

3. Press the Clear All button on the copier.

4. From your application, select Bypass Tray as the Paper Source in the Page Setup or 
Print dialog box.

If Interleaved mode is selected in the Print Options dialog box, one of the paper trays 
must be loaded with a paper the same size and orientation as the transparencies in the 
bypass tray.

5. Select the correct page size in the Page Setup or Print dialog box.

6. Click Print in your application.
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Using the color reference pages
The Fiery SI User Software includes several types of color reference pages that you can 
view and print to see the full range of colors available from your Fiery SI.

• The CMYK Color Reference pages enable you to view and print CMYK color 
patches in the range of colors the Fiery SI can print. 

• Color Charts is a downloadable PostScript file of the color charts that can be printed 
from the Control Panel.

• The RGB Color Reference pages are a Microsoft Word and a Microsoft PowerPoint 
file that you can open in the application to view the colors available in the standard 
palette for that application and see how they print on the Fiery SI.

• The PANTONE books are downloadable PostScript files that simulate all of the 
PANTONE colors available from your Fiery SI.

The CMYK Color Reference file and the PANTONE books are installed by the 
installer. The other color reference pages are in the CLRFILES folder on your User 
Software CD. You can install them individually as needed as described in Getting 
Started.

NOTE: When you print these files, you can try different color rendering styles to find 
the best results for your needs.
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CMYK Color Reference pages
The Color Reference folder contains a PostScript file of color reference pages that you 
can download to your Fiery SI. You can use the pages as a reference for graphics 
applications that allow you to specify color as values of cyan, magenta, yellow, and 
black. The pages display groups of color patches and give you the percentage of each 
process color required to achieve the color shown. There are eleven pages—each one 
shows colors from 0% to 100%.

TO PRINT AND USE THE CMYK COLOR REFERENCE PAGES:

1. Use the Fiery XJ Downloader to download the CMYK—REF.PS file.

For information on using the Fiery XJ Downloader, see “Downloading files and fonts” 
on page 5-1.

If you do not have Fiery XJ Downloader installed, print the file as you would any other 
PostScript file.

2. Select the color that you want to use from the color reference page.

3. Enter the corresponding cyan, magenta, yellow, and black values in any application 
that supports CMYK.

Color charts 
The color charts are a PostScript version of the charts you can also print from the 
Control Panel. They are designed to look best when the copier is calibrated to the 
copier standard and not one of the press standards.

TO PRINT AND USE THE COLOR CHARTS:

• Use the Fiery XJ Downloader to download the COLORCHT.PS file.

For information on using the Fiery XJ Downloader, see “Downloading files and fonts” 
on page 5-1.
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RGB Color Reference pages
The RGB Color Reference pages display the RGB colors available in Microsoft Word 
and PowerPoint.

TO PRINT AND USE THE RGB COLOR REFERENCE PAGES:

1. Open Microsoft Word or PowerPoint.

2. Open the APLPAGES\RGB_REF folder and open the RGB01.DOC (Microsoft Word) or 
RGB02.PPT (Microsoft PowerPoint) file.

3. Choose Print from the File menu.

4. Select the color that you want to use and enter the corresponding values for colors you 
want to reproduce in your own Word or PowerPoint document.

PANTONE books
The PANTONE book files print standard PANTONE colors as they appear when 
printed on a Fiery SI. There are PANTONE books that simulate coated and uncoated 
paper stock for all supported devices.

TO PRINT AND USE THE PANTONE BOOKS:

1. Use the Fiery XJ Downloader to download the Coated or Uncoated PostScript file that 
corresponds to your device.

These files are installed in the Color Reference folder by the installer. For information 
on using the Fiery XJ Downloader, see “Downloading files and fonts” on page 5-1.

2. Enter the PANTONE color number in an application that supports specifying colors that 
way.



44-1 Scanning documents
Fiery XJ Scan is a Photoshop plug-in module that enables you to perform additional 
functions with your Fiery SI. Fiery XJ Scan allows you to scan an image from the 
copier directly into Photoshop on your computer. This Photoshop plug-in is provided 
with the Fiery XJ software.

You cannot use the Fiery SI Photoshop plug-ins with the parallel port.

NOTE: The utilities for Macintosh and Windows users are fundamentally the same; 
differences are noted in this chapter. When you see a window or dialog box illustrated, 
the Macintosh version comes first, followed by the Windows 95 version.

Scanning documents
Fiery XJ Scan is a plug-in for use with Adobe Photoshop version 2.5 or later. First you 
create a prescan of the image; then you can select part or all of the prescan for final 
scanning.

TO PRESCAN A DOCUMENT:

1. Start the Photoshop application.

2. Place the original you want to scan on the copier.

3. Choose Fiery XJ Scan from the Acquire submenu of the File menu.

Chapter 4:
Scanning Jobs 



44-2 Scanning Jobs
4. Select the Fiery SI in the Chooser window that appears and click Connect or OK.

5. Specify information about the job in the Fiery XJ Scan main window that appears.

Prescan size—Choose the paper size of the original from the menu. You can scan a 
Letter or A4 original from the copier.

Resolution—Specify a value for the resolution. Changing the resolution changes the 
image size. The maximum resolution supported by your Fiery SI appears in the dialog 
box.

Scan Mode (Full Color, Grayscale, or Black & White)—Specify the type of scan you 
want.
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6. Click Prescan.

The image appears on the left side of the window.



44-4 Scanning Jobs
TO SELECT OPTIONS AND COMPLETE THE SCAN:

1. Drag the cursor to select the area of the prescan image that you want to acquire, or 
enter the area to acquire in the Selection area.

In the Selection area, you can specify:

Units (inches, centimeters, picas, points, ciceros, or pixels)—Specify the ruler units 
that appear around the preview image.

Width and Height—Enter the Width and Height of the area to scan. If you select an 
area of the page with the selection marquee, its dimensions appear in these text boxes. 
If you do not select a prescan area, the default is to acquire the entire scan.

You can use the selection marquee to select an area of the image that you want to 
acquire, or you can acquire the entire image. When you select a portion of the image, 
you can move the selection marquee around by positioning the pointer inside the 
marquee and dragging the marquee to a new location. If you want to deselect the area 
you have selected, click outside the selected area. Double-click to reselect the whole 
scan.

You can change the size of the frame by clicking and dragging one of the handles on 
the corners of the selection frame.

The Fiery SI scans at a maximum resolution that is dependent on the size of the 
scanned area. For letter or A4 paper sizes, the maximum scan resolution is 200 dpi. For 
an area that is roughly one-fourth the size of letter/A4, the maximum scan resolution is 
400 dpi. If you select a size in this range, you can type a resolution of up to 400 in the 
dialog box.

2. If you want to change any options, click Options to display the Scan Options dialog 
box. Click OK when you are finished.
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Resampling—Select the resampling interpolation method to use. In general, you 
should choose Photograph if you are scanning a continuous tone photographic image 
and Offset Print or Copy if you are scanning a printed document. The Offset Print or 
Copy mode takes slightly more time but reduces moiré patterns in scans. 

Color Conversion—Select the color conversion to use: Calibrated RGB or Match 
Copy (the default copier CMYK conversion). You should use Calibrated RGB if you 
will be using EFICOLOR or if you may want to print the image to any other printer. 
You should choose Match Copy to match colors in a copy from the glass as closely as 
possible assuming that you are going to print the image to the same copier and you do 
not want to use EFICOLOR. 

3. Click Scan in the main window to acquire the scan.

The progress bar displays how much of the image has been processed. You can click 
Cancel to cancel acquiring the scan.

When the scan is acquired, the scanned image is displayed in Photoshop.
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5-1 Downloading files and fonts

 

The following utilities to help you manage print jobs are provided on the User 
Software CD or floppy disks:

•

 

The Fiery XJ Downloader

 



 

 is a utility that allows you to print PostScript and 
Encapsulated PostScript files directly to the Fiery SI without using the application 
they were created in. The Fiery XJ Downloader also enables you to manage printer 
fonts on the Fiery SI.

• The Fiery XJ Spooler

 



 

 is a utility that allows you to view the order and priority of 
print jobs, delete jobs, and move jobs between queues. You can also use it to view job 
accounting information.

You cannot use the Fiery XJ utilities with the parallel port.

 

N

 

OTE

 

:

 

The utilities for Macintosh and Windows users are fundamentally the same; 
differences are noted in this chapter. When you see a window or dialog box illustrated, 
the Macintosh version comes first, followed by the Windows 95 version.

 

Downloading files and fonts

 

You can use the Fiery XJ Downloader to: 

• Print PostScript, and Encapsulated PostScript (EPS) files. 

• Check the status of the Fiery SI.

• Manage the PostScript printer fonts stored on the Fiery SI’s hard disk.

 

N

 

OTE

 

:

 

You can also use standard LaserWriter downloaders, such as the Adobe Font 
Downloader, with the Fiery SI. The Fiery XJ Downloader was designed specifically for 
the Fiery. You cannot use the Fiery XJ Downloader with any other printer. 

Chapter 5:
Managing 
Print Jobs
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T

 

O

 

 

 

VIEW

 

 

 

INFORMATION

 

 

 

WITH

 

 

 

THE

 

 F

 

IERY 

 

XJ D

 

OWNLOADER

 

:

 

1. Double-click the Fiery XJ Downloader icon or choose Fiery XJ Downloader from the 
Windows 95 Start button.

2. Select the Fiery SI in the Chooser window that appears and click Connect or OK.

 

The Fiery XJ Downloader’s Status window appears and you see the Toolbar, Fiery XJ 
Downloader’s menu(s), and the status bar at the bottom of the screen. 
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Icons for some menu functions display in the Toolbar at the top of the window. Click 
the button to perform the function. The icons are:

The Print Status region displays the server status and the user name and document 
name of the job currently printing.

The RIP Status region displays the server status and the user name and document 
name of the job currently processing. 

Open Click this button to connect to a different Fiery SI.

Download Click this button to download a file or font to the 
Fiery SI.

Display font list Click this button to display a list of printer fonts on the 
Fiery SI’s hard disk.

Display status 
window

Click this button to display the status window for the 
current Fiery SI.

 

 

 

About the 
Downloader

Click this button to view version information about the 
Fiery XJ Downloader. (Windows only)
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The Download Progress bar displays the amount of a job processed when you 
download a job to the printer.

The Fiery XJ Hard Disk region displays the amount of available disk space.

You can click the Display Font List button or choose 

 

Font List 

 

from the File menu to 
view font information in the window.

 

3. To select a different server, choose Open from the File menu, select the Fiery SI in the 
dialog box that appears, and click OK or Connect.

4. To close the window, choose Close from the File menu; to close the application choose 
Quit (Macintosh) or Exit (Windows) from the File menu.

 

Printing with the Fiery XJ Downloader

 

Printing PostScript files with Fiery XJ Downloader is fast—generally faster than 
printing from within applications. If you regularly print large files, be sure to try 
printing with the Fiery XJ Downloader.

 

T

 

O

 

 

 

DOWNLOAD

 

 

 

A

 

 

 

FILE

 

 

 

OR

 

 

 

FONT

 

 

 

WITH

 

 

 

THE

 

 F

 

IERY 

 

XJ D

 

OWNLOADER

 

:

 

1. Use your application to generate a file.

 

You can save a PostScript file by selecting the PostScript option in the application’s 
Print dialog box. With some applications, you can save Encapsulated PostScript (EPS) 
files.

If you experience problems printing EPS files with the Fiery XJ Downloader, you can 
print the file directly from the application in which you created it.

 

2. Double-click the Fiery XJ Downloader icon.
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3. Choose Download from the File menu or click the Download button.

 

A dialog box containing a list of files appears.



 

5

 

5-6 Managing Print Jobs

4. Select the file type to display in the Show (Files of Type) menu.

 

You can leave this at the default 

 

All known formats

 

, or select 

 

All Files

 

. 

 

All known 
formats

 

 will list all files in formats supported by the Fiery XJ Downloader; 

 

All Files

 

 
will list all files.

 

N

 

OTE

 

:

 

You can download files and fonts in the same batch.

 

5. Select where to download the file or font in the Queue (Connection type) pop-up 
menu.

 

You can select the 

 

Print

 

 queue, 

 

Hold

 

 queue, or 

 

Direct

 

 connection. If the connection is 
not enabled, an error message will appear.

 

6. Select the filename and click Add (File[s]).

 

The File name field (Windows) displays the name of the selected file before you click 
Add.

You can use the dialog box to move to different drives and directories to select files to 
download. Click 

 

Add All

 

 (Macintosh) to add all files in a folder.

If you change your mind about a file, select the filename in the 

 

Files to Download

 

 list 
and click 

 

Remove (Files)

 

.

Click 

 

Remove All 

 

(Macintosh) to remove all files from the 

 

Files to Download

 

 list.

 

7. To change attributes of a job, select it and click Options. 
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8. Specify the following information in the dialog box and click OK.

 

Copies

 

—Specify the number of copies you want by entering the number in the 

 

Copies 

 

text

 

 

 

box.

 

Brightness

 

—Change the Brightness setting if a file prints too dark or too light. Select 

 

85%

 

 for a substantially lighter image, 

 

115%

 

 for a substantially darker image, or one of 
the options in between. 

 

N

 

OTE

 

:

 

Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Fiery XJ Downloader 

 

Brightness 

 

options will have no effect on 
your printout. For more information on using transfer functions, see the 
documentation for your application.

 

‘showpage’ (after EPS files)

 

—In most cases, you do not need to use this option. Select 
the 

 

‘showpage’ 

 

option only if an EPS file fails to print without it. This option adds a 

 

showpage

 

 PostScript language command at the end of the print job. Some applications 
omit this necessary PostScript language command when they generate EPS files. Select 
this option when printing EPS files generated by these applications. If you select this 
option unnecessarily, extra blank pages may print.

 

9. Repeat steps 7 and 8 for any other jobs as needed.

10. When you have selected all files and fonts, click Download.

11. To cancel downloading, press Command-. (Period) on a Macintosh, or the Escape key on 
a PC.

12. To select a different Fiery SI, choose Open from the File menu, select the Fiery SI in 
the dialog box that appears, and then click Connect.

 

Downloading and managing printer fonts 

 

Before printing a PostScript or EPS file containing fonts that are not resident on the 
Fiery SI’s hard disk, you must download the fonts manually. 

The Fiery SI comes with 39 PostScript fonts. These include regular, bold, italic, and 
bold italic versions of the following fonts: Courier, Times, Helvetica, Helvetica 
Condensed, Helvetica Narrow, ITC Avant Garde Gothic, Demi, ITC Bookman, New 
Century Schoolbook, and Palatino. Also included are ITC Zapf Chancery, ITC 
Symbol, and ITC Zapf Dingbats. 
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You cannot use the Fiery XJ Downloader to download TrueType fonts.

 

N

 

OTE

 

:

 

If you are using TrueType fonts in Windows, you can print them by converting 
them to Adobe Type 1 fonts. To do this with the Adobe PostScript printer driver, click 
the Fonts tab and select 

 

Send TrueType Fonts to This Printer as Type 1

 

. To do this 
with the Windows 3.x printer driver, set the 

 

Send to Printer as Adobe Type 1

 

 
command in the Advanced Options dialog box. To do this with the Windows 95 
printer driver, click the Fonts tab and select 

 

Always use built-in printer fonts instead 
of True Type fonts

 

.

Printer fonts and Macintosh screen fonts 

Like all PostScript fonts, the fonts included with the Fiery SI come in two forms: 
printer fonts and screen fonts. The printer fonts are installed permanently on the 
Fiery SI’s hard disk. The screen fonts, which are included with the Fiery SI, should be 
installed on your Macintosh. If you are using these fonts in documents you print on a 
LaserWriter, they are probably already installed. If not, you’ll need to install them 
yourself. See Getting Started for instructions.

Occasionally, you may want to use PostScript (Macintosh) or Adobe Type 1 
(Windows) fonts that are not included with the Fiery SI. If so, you’ll need to install 
both the screen fonts and the printer fonts on your computer. To do this, follow the 
instructions from the font manufacturer. 
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Downloading printer fonts to the Fiery SI 

In general, each time you print from within a Macintosh application, the application 
automatically downloads any fonts used in your document that are not already 
installed on the Fiery SI, as long as the printer fonts are installed in your System 
Folder. These fonts remain in the Fiery SI only until your document has printed. If you 
print the same document again, your application must download the fonts again.

If you regularly use one or more fonts from Macintosh or Windows applications that 
are not already installed in the Fiery SI, you can save time by downloading them to the 
Fiery SI’s hard disk with the Fiery XJ Downloader. Fonts you download to the 
Fiery SI’s hard disk remain installed until you remove them using the Fiery XJ 
Downloader, no matter how many times the Fiery SI is turned off and on. You’ll 
probably want to download fonts you use on a regular basis to the Fiery SI’s hard disk. 

Before you print PostScript or Encapsulated PostScript (EPS) files using the Fiery XJ 
Downloader, make sure that all fonts included in your file are installed in the 
Fiery SI. If your file contains fonts that are not installed on the Fiery SI, the text in 
these fonts will not print correctly and may not print at all. With some applications, 
you can include fonts when you create PostScript files. See your application software 
for information.
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TO VIEW FONT INFORMATION:

1. Choose Font List from the File menu or click the Font List button.

The Font List window appears with Update, Print, and Delete buttons in the title bar.

The icons are:

Update Click this icon to update the information in the font list window.

Print Click this icon to print the font list to the Print queue.

Delete Select a font and click this icon to delete it.
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2. Click the Update button to update the information in the list.

3. Click the Print Font List button to print the font list. 

4. Select a font and click the Delete button to delete the font.

Shift-click to select multiple fonts.

NOTE: The printer fonts included with the Fiery SI (resident fonts) are locked. Locked 
fonts appear with a lock icon next to the name and cannot be deleted.
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Using the Fiery XJ Spooler
The Fiery XJ Spooler lets you monitor and manipulate the print jobs that you send to 
the Fiery SI. It also lets system administrators track and manage all users’ print jobs. 

Spooler jobs can be in one of the following queues:

Jobs in the queues are stored on the Fiery SI’s hard disk. Make sure that you leave 
enough space on the hard disk for fonts and others spooler jobs.

You can use the Fiery XJ Spooler Job Log to view information about jobs printed to 
the Fiery SI for job accounting purposes or saved for reference. The Job Log can be 
printed to the Fiery SI or saved as a file and viewed in other applications.

Print Normal print jobs sent to the Fiery SI appear in the Print queue. 
You can move and manipulate these jobs as described below.

Hold Jobs sent to the Hold queue remain in the Hold queue until they 
are moved to the Print queue or deleted. If you need to print the 
same document frequently, you can send it to the Hold queue and 
move a copy of the job to the Print queue every time you need to 
print it. You can also send large jobs to the Hold queue and then 
move them to the Print queue when other users are not printing.

Printed The jobs most recently sent to the Fiery SI are saved in the Printed 
queue. You can drag these jobs back to the Print queue to print 
additional copies. The number of jobs saved in the Printed queue is 
set by your system administrator in the Setup. 
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TO USE THE FIERY XJ SPOOLER:

1. Double-click the Fiery XJ Spooler icon or choose Fiery XJ Spooler from the Windows 95 
Start button.

2. Select the Fiery SI in the Chooser window that appears.

3. Click Connect or OK.

The Fiery XJ Spooler main window and File, Edit, Window, Help (Windows), and 
Administrator menus appear. 

Available disk space

Server name

Current Print and RIP status

Name of the job currently 
printing

Scroll list of every document sent 
to the Print Queue

Scroll list of every document sent 
to the Hold Queue

Jobs with PostScript errors appear 
in Printed queue with Alert icon

Name of the job currently 
processing
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The job list includes information about the document name, user name, time and date 
sent, print device, and file size. 

The window is split into regions that correspond to the different queues and steps in 
the printing process. You can click and drag a job to the Print or Hold region of the 
window to move it to the corresponding queue. 

Available disk space

Server name

Current Print and RIP status

Name of the job currently 
printing

Scroll list of every document sent 
to the Print Queue

Scroll list of every document sent 
to the Hold Queue

Jobs with PostScript errors appear 
in Printed queue with Alert icon

Name of the job currently 
processing
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The icons provide information about the job:

Icons also appear above the scroll list. The icons are:

Printing Print icon The job that is currently printing appears in this list. It can be selected 
and deleted to cancel printing.

Waiting Print icon Jobs that have been processed and are waiting to be printed appear in this 
list. Although they can be selected and deleted to be canceled, they are 
dimmed because their settings cannot be changed and they can’t be 
moved.

Ripping RIP icon Jobs that are processing appear in the scroll list, but they are dimmed 
because their settings cannot be changed and they can’t be moved or 
canceled.

Print Print icon Jobs that are waiting to be printed that have not been processed appear 
with the Print icon. This list shows jobs in the order they will be printed. 

Hold Hold icon Jobs in the Hold queue appear with the Hold icon. You can move the job 
to the Print queue to print it.

Printed Printed 
icon

Jobs that have been printed are saved in the Printed queue and appear 
with the Printed icon. Jobs are stored in the Printed queue until the limit 
set by your system administrator in the Printer Setup on the Control 
Panel is reached. 

Printed Alert icon If a PostScript error occurred while a job was printing, it appears in the 
Printed queue with an Alert icon next to it. You can double-click the 
Alert icon to display the error message.

Update Click this icon to update the information in the Fiery XJ Spooler 
main window.

Duplicate 
and Print

Drag a document onto this icon or select the document and click 
this icon to duplicate it and put the duplicate in the Print queue.
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4. Choose Preferences from the Edit menu to specify how the Fiery XJ Spooler behaves.

The Preferences window appears. 

You can use this window to specify that the Fiery SI:

Update Automatically every n seconds or Update Manually—This option lets you 
specify whether the Fiery XJ Spooler main window is automatically updated every 20 
seconds (or at an interval that you set), or whether it is updated only when you choose 
the Update command from the Window menu. By default, the Fiery XJ Spooler main 
window is updated automatically every 20 seconds.

NOTE: When automatic updating is on, data is coming from the Fiery SI across the 
network very frequently. This data adds to the network traffic, and may slow down 
other network jobs. For optimum network performance, turn off automatic updating 

Print Drag a document onto this icon or select the document and click 
this icon to print it to the Print queue.

Hold Drag a document onto this icon or select the document and click 
this icon to save it in the Hold queue.

Delete/
Cancel

Drag a file onto this icon or select the document and click this icon 
to delete it or cancel processing or printing it. You will be asked to 
verify that you want to delete the job. You can eliminate the 
verification notice by turning off the Confirm file deletion option 
in the Preferences window.
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in the Fiery XJ Spooler Preferences dialog box; when you want to view updated 
information in the Fiery XJ Spooler windows, choose Update from the Window menu 
or click the Update icon.

Confirm file deletion—Select this if you want a confirmation dialog box to appear 
before you delete a file.

5. If you selected Manual updating in the Preferences window, choose Update from the 
Window menu to update the information in the Fiery XJ Spooler window.

6. To display information about a different Fiery SI, choose Open from the File menu. 

The Chooser window appears. 

7. Select the Fiery SI in the Chooser.

The Fiery XJ Spooler main window appears and displays information about the 
Fiery SI you selected.

NOTE: You can move between Fiery XJ Spooler windows by choosing the Fiery SI name 
in the Window menu. You can move between the Job Log and Main windows for a 
server by choosing them in the Window menu. You can also use the Cascade option in 
the Window menu to organize windows on your Desktop. 

8. Choose Close from the File menu to close the connection to the current Fiery SI; 
choose Quit (Macintosh) Exit (Windows) from the File menu to quit the Fiery XJ 
Spooler.

Duplicating, copying, moving, and deleting jobs
Macintosh, Windows 95, and Windows NT users can move, delete, and configure 
their own print jobs; the Fiery SI system administrator (or anyone with Fiery XJ 
Spooler Password access) can move, delete, and configure jobs for all users, and can re-
order jobs within a queue. Windows 3.x users can delete, configure, and move jobs 
between queues. The Fiery SI system administrator (or anyone with Fiery XJ Spooler 
Password access) can re-order jobs within a queue.

You can move your jobs from the Hold queue and the Printed queue to the Print 
queue. If, for example, you frequently print the same file, you can send it to the Hold 
queue and later drag a copy of the file to the Print queue. By copying rather than 
moving a job, you leave a copy of the job in the Hold queue so that you can print the 
job again later. You can also duplicate a job if you want to have multiple copies of a job 
in the same queue.
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Duplicating jobs

You can duplicate jobs in the Print, Printed, and Hold queues:

• If you want to change printing parameters in the Override Print Settings window 
without losing the original settings.

• If you want to print more than 20 copies to the sorter. (The maximum number of 
copies that you can print to the sorter is 20).

When you duplicate a job, the Fiery SI creates a reference to the original file, so 
duplicate files do not require the full amount of disk space on the Fiery SI. As long as 
one of the duplicates remain, the Fiery SI saves the file, so you can delete all but one 
reference to a file.

TO DUPLICATE A JOB WITHIN A QUEUE: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

2. Choose Duplicate Job from the Edit menu.

The job appears at the bottom of the queue. 

TO DUPLICATE AND PRINT A JOB: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted.If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

2. Click the Duplicate and Print icon, or drag the job to the Duplicate and Print icon.

The job appears at the bottom of the Print queue. 
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TO COPY A JOB TO ANOTHER QUEUE:

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

2. Hold down the Option (Macintosh) or Ctrl (Windows) key as you drag the job to either 
the Hold or Print queue icon or to the Hold or Print section of the job list.

A copy of the job is moved to the queue you have selected, but the original job still 
appears in the Hold or Printed queue so that you can print the job at another time.

TO MOVE A JOB WITHIN A QUEUE:

1. Choose Password from the Administrator menu and enter the password.

If there is no password, go to step 2.

2. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

3. Drag the file to the new location in the queue.

TO MOVE JOBS BETWEEN QUEUES:

1. Select the job that you want to move by clicking its name. 

The selected job is highlighted.If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

2. Move the selected job to another queue by dragging it to the queue icon of your choice 
or to the Hold or Print section of the job list.

For example, move a job that is currently in the Hold queue to the Print queue by 
dragging the job to the Print queue icon. 
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TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the Delete icon or click the Delete icon.

You can also choose Delete from the Edit menu to delete a selected job.

You can only delete your own jobs; system administrators who enter the Fiery XJ 
Spooler password can delete any job. (Macintosh, Windows 95, and Windows NT)

Changing print settings for a job
You can set certain printing parameters for a job in the Override Print Settings dialog 
box. The settings in this dialog box override the settings in the Print Options dialog 
box and the Control Panel Printer Setup.

You can change printing parameters only for jobs in the Hold, Print, and Printed 
queue sections of the Fiery XJ Spooler main window.

You can change print settings only for your own jobs; system administrators who enter 
the Fiery XJ Spooler password can change print settings for any job (Macintosh, 
Windows 95, and Windows NT). 
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TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a job or select the job and choose Override Print Settings from the Edit 
menu.

The Override Print Settings window appears. 

2. Choose the new settings from the pop-up menus.

If you select Default Settings, the job will use the settings in the Print dialog box. 

For information about these options, see Appendix D "Setting Job Overrides."

3. Click OK to make changes.
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Using the Job Log
With the Fiery XJ Spooler, you can view and print a log of all the jobs printed to the 
Fiery SI. You can also save the Job Log as a text file that you can then import into a 
spreadsheet or word processing application for job accounting purposes. All jobs 
printed to the queues, printed by direct connection, and scanned from the copier are 
listed in the Job Log.

TO DISPLAY, PRINT, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Window menu.

2. Specify the period for the Job Log in the window that appears.

Click All to view all jobs since the Job Log was cleared; click Date if you want to 
specify a period of time for the Job Log.

3. Click OK.

The Job Log window displays a list of all the jobs and the following information about 
them: status, document name, user name, date, start time, end time, process time, file 
size, print device, paper size, media, number of originals, number of color pages, 
number of black and white pages, total number of pages, note 1, and note 2.
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The information in the note fields is specified in the Print dialog box if you are using 
the Adobe PostScript printer driver. 

Use the scroll bar at the bottom of the window to view all fields in the Job Log 
window.

The text in the Status column provides information about the job:

4. To print the Job Log, choose Print Job Log from the File menu or click the Print icon at 
the top of the window.

The information displayed in the Job Log window prints to the current Fiery SI. 
When you print the Job Log, totals are printed for all appropriate columns.

5. To save the Job Log as a file that you can view with a different application, choose 
Export Job Log from the File menu or click the Export icon at the top of the window.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You can 
double-click ERROR to display the error message. A dialog box 
displays the PostScript error. Click OK to close the dialog box.

CANCEL The job was canceled before printing was completed.

Print 

Export 

Update

Print

Export

Update
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6. Enter a name for the log file, and click Save. 

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

7. If you entered the Administrator password, you can choose Delete Job Log from the 
File menu to clear the Job Log. 

The system administrator can also print and clear the Job Log from the Control Panel.

TO USE ADMINISTRATOR FUNCTIONS:

1. Choose Password from the Administrator menu.

This menu is active only if a password was created on the Fiery SI.

2. Enter the password in the window that appears. 

This password is set in the Setup on the Control Panel. If you enter the password on a 
Macintosh or PC with Windows 95 or Windows NT, you can move, override, and 
delete all users’ jobs in the Fiery XJ Spooler main window and re-order jobs within a 
queue. If you enter the password in Windows 3.x, you can re-order jobs within a 
queue.
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Setting up automatic paging

In the United States and Canada, if you have PageNOW! paging software installed on 
your Macintosh computer, you can set up the Fiery XJ Spooler to notify you if there is 
a problem with printing. To use this feature:

• Both PageNOW! and the Fiery XJ Spooler must be running on your Macintosh.

• You must be connected to the server you want to monitor in the Fiery XJ Spooler.

TO SET UP AUTOMATIC PAGING:

1. Set up your user name in PageNOW!

See the PageNOW! documentation for instructions.

2. Choose PageNow username from the Fiery XJ Spooler Administrator menu.

3. Enter your User Name.

4. Choose Start Error Paging from the Administrator menu to enable automatic paging. To 
stop paging, choose Stop Error Paging from the Administrator menu.

You can monitor the messages sent to the pager from within PageNOW! See your 
PageNOW! documentation for information.
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Calibrating your Fiery SI ensures consistent, reliable color output. You can calibrate 
the Fiery SI in several ways:

• Scan a page from the copier glass and use automatic calibration (AutoCal™).

• Connect a densitometer to your Fiery SI and calibrate it from the Control Panel.

• Connect a densitometer to your Macintosh or IBM PC-compatible and download 
calibration to your Fiery SI with the Fiery XJ Print Calibrator.

This chapter describes the function of calibration and describes how to calibrate your 
Fiery SI.

NOTE: Changing calibration affects all jobs for all users, so you may want to limit the 
number of people authorized to calibrate the Fiery SI and use Fiery XJ Print 
Calibrator.

Understanding calibration
Calibration allows you to:

• Maximize the color reproduction capabilities of the Fiery SI

• Ensure consistent color quality across time

• Produce consistent output across Fiery SI servers of the same kind

• Optimize your Fiery SI for use with EFICOLOR color management software

• Use your Fiery SI as a proofing system

• Achieve better color matches when you’re reproducing spot colors, such as 
PANTONE colors or other named color systems

• Linearize your Fiery SI while maintaining the currently available density range

• Create custom calibration targets and custom calibration curves

Chapter 6:
Color 
Calibration
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How calibration works
Success in obtaining satisfactory print quality from a digital color printer depends on 
many factors. Among the most important are establishing and maintaining optimal 
toner densities. Density is a measure of the light absorbed by a surface. The saturation 
of toner colors, which affects output densities from your copier, is affected by such 
variables as room humidity and service settings, and also tends to drift over time. 
Regular calibration corrects for day-to-day variations in densities.

Calibration works by creating calibration curves on your Fiery SI server that 
compensate for deviations from desired density values. These calibration curves are 
generated by creating a measurements file—a file containing numerical values 
corresponding to the amount of toner being printed for the full range of colors—and 
comparing it to a target.

Measurements

Measurements files provide numerical values that correspond to your copier’s toner 
density for each color. To create a measurements file, you can scan a page from your 
copier and use AutoCal, connect an X-Rite DTP32 densitometer to the Fiery SI and 
record values, or connect an X-Rite DTP32 densitometer to your Macintosh 
computer’s modem port or your IBM-PC compatible’s serial port and measure values 
with the Fiery XJ Print Calibrator. You may also be able to connect any Status T 
densitometer to your Macintosh or IBM-PC if you have utility software provided by 
the densitometer manufacturer to create a measurements file.

Targets

Target files define desired calibration results. Several target files are provided with the 
Fiery SI, and you can create additional ones as needed by modifying existing targets. 
When you calibrate the Fiery SI, you can select the target file that corresponds to the 
type of printing you are doing.

The targets provided with the Fiery SI are:

• 5760/65 or 5790—Optimized for best results for specific copier performance. You 
should use the copier target if you are going to use the copier’s ICC profile to print 
CMYK data or the Color Rendering Dictionaries (CRD). The CRDs are used if you 
print an RGB file from Photoshop, or if you use a PostScript Level 2 Printer Driver 
(Adobe PostScript Printer Driver for Macintosh, Adobe PostScript Printer Driver for 
Windows, or Apple LaserWriter Printer Driver version 8.0 or later).
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• DIC—Japanese press standard.

• Euroscale—European press standard.

• Linear—Results in output that divides the maximum measured density for each 
color into equal density steps to provide an even distribution of tones over the 
copier’s density range. When you linearize the Fiery SI, the entire measured density 
range in each color channel is divided into equal steps. Equal steps in ink percentage, 
such as 0%, 10%, and 20%, are printed in equal steps in density, and appear as 
roughly equal visual steps. This gives a linear response using the range of densities 
available.

• SWOP-Coated—US press standard.

Scheduling calibration
In general, you should calibrate the Fiery SI at least once a week. If it is very important 
to maintain consistent colors, or if your Fiery SI is subject to wide fluctuations in 
temperature or humidity, you should calibrate every few hours. In general, to get the 
best performance from your copier, calibrate whenever there is a noticeable change in 
print quality.

If you need to split a print job into two or more batches, it is especially important to 
calibrate before printing each batch.

You should also calibrate your Fiery SI system after copier maintenance. However, 
because your copier may be unstable immediately after maintenance, you should wait 
until you have printed approximately 50 pages before you calibrate.

NOTE: Copier output is very sensitive to changes in temperature and humidity. To 
minimize these effects, your copier should not be installed near a window or in direct 
sunlight, or near a heater or air conditioner.

Your copier may have a self-calibration feature that optimizes toner densities after 
scanning a test page on the copier glass or some other method. You can use this feature 
in conjunction with Fiery SI calibration. Always run the copier’s self-calibration 
routine before calibrating. Using the copier’s calibration feature alone will not 
necessarily bring output densities from your copier to the optimal values for Fiery SI 
printing.
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Set up a standard printing environment in Control Panel Setup by selecting printing 
options that correspond to the way you usually print. Then print one or more standard 
color pages. You can print the Color Charts from the Control Panel and the Color 
Reference pages that are included with your user software. See “Using the color 
reference pages” on page 2-5 or page 3-15. All of these pages include fully saturated 
color patches and pale tints of cyan, magenta, yellow, and black. Images with skin 
tones offer a very good basis for comparison. You can save and compare pages you 
printed at different times. If there is a noticeable change in appearance, you should 
calibrate or linearize your Fiery SI system.

If your solid density patches (100% cyan, magenta, yellow or black) look less saturated 
with time, show the pages to the copier or printer technician to find out if an 
adjustment can be made to improve the output.

Checking calibration status
Before printing a job, you should check to see whether the Fiery SI is calibrated, what 
target was used, and when the printer was last calibrated. You can view information 
about the last calibration:

• At the Fiery SI, by printing a Configuration page or Test Page from the Control 
Panel Functions menu.

• With the Fiery XJ Print Calibrator by choosing Calibration Status from the Server 
menu. This method gives you additional information. See “To view information 
with the Fiery XJ Print Calibrator:” on page 6-13.

Using a densitometer
If you calibrate your Fiery SI from either the Control Panel or the Fiery XJ Print 
Calibrator, you can use a densitometer to input color information. The procedure is 
the same in both cases. 

For additional information about setting up and using your densitometer, see the 
documentation that came with it.

Setting up the densitometer

Before you calibrate the Fiery SI, configure and zero your reflection densitometer to 
prepare for measuring the printed patches. 
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TO CONNECT THE X-RITE DTP32:

1. Plug the square end of the interface cable (like a modular phone plug) into the I/O 
port on the side of the X-Rite DTP32.

2. Attach the round 8-pin mini-connector to the modem port on the back of your 
Macintosh. Or attach the 9-pin connector to the COM1 or COM2 port on your PC. Or 
attach the 9-pin connector to the serial port on the back of the Fiery SI.

Square connector

Macintosh PCServer
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3. If you are using a Macintosh, attach the round 4-pin mini-connector to one of the 
Apple Desktop Bus (ADB) ports.

The Macintosh ADB port provides power to the DTP32.

4. If you are using a PC, a Macintosh without an ADB port available (or a PowerBook), or 
the Fiery SI, use the optional AC adapter (available from X-Rite) to provide power. If 
you use the optional AC adapter, plug the small connector on the adapter cable into 
the side of the X-Rite DTP32 and plug the adapter into a wall outlet.

TO CONNECT THE X-RITE DTP32 TO A POWERBOOK:

1. Turn the PowerBook off.

2. Connect the network cable to the PowerBook’s EtherTalk port.

3. Plug the square end of the densitometer interface cable into the I/O port on the side 
of the X-Rite DTP32.

4. Attach the round 8-pin mini-connector to the serial port on the PowerBook.

5. If the densitometer display indicates that densitometer battery power is low, use the 
external AC adapter for the densitometer.

NOTE: Don’t connect the densitometer to the PowerBook ADB port.

AC adapter

Small connector
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6. Configure the densitometer to factory defaults and save the settings. (See the 
densitometer manual for details.)

Factory default settings for the X-Rite DTP32 are:

7. Turn on the PowerBook.

8. In the PowerBook Setup Control Panel, select Normal for Modem Controls.

9. Calibrate the densitometer, as described below.

TO CALIBRATE THE X-RITE DTP32:

1. On the X-Rite DTP32, simultaneously press the two buttons marked MENU.

The words MAIN MENU appear in the display.

2. Press the p1 key until p2 appears.

3. Press the cal key.

CALIBRATION appears in the display.

4. Press the den key.

CALIBRATING TRANSMISSION is displayed, followed by the words INSERT CAL STRIP.

5. Position the strip guide at 5.

6. Insert the arrow end of the Auto-Cal strip into the entrance of the X-Rite DTP32 until 
the roller starts pulling the strip.

Page 1 LANG (ENG) TONE (loud) TYPE (ser)

Page 2 BAUD (9600) HAND (xon) AXMT (on)

Page 3 DPT (on) SEP (spc) DLIM (crlf )

Page 4 DEF (off ) X10 (off ) DAP (off )

Page 5 M/M (max) LOCK (off )

Strip guide
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READING appears momentarily, followed by the density values and CALIBRATION OK.

If UNRECOGNIZABLE STRIP appears, try cleaning the strip (see your X-Rite DTP32 
Operating Manual).

7. Recalibrate the densitometer at least once month.

Measuring values with a DTP32 densitometer
You can connect a DTP32 densitometer to the Fiery SI or to your Macintosh or PC if 
you are using Fiery XJ Print Calibrator. The densitometer scans the density of the first 
patch, automatically advances to the next patch, and automatically transmits the 
measured values to the Fiery SI or Fiery XJ Print Calibrator. The DTP densitometer 
has an adjustable strip guide to the right of the strip entrance. 

After each column is scanned, the density measurements are used to create a 
Measurements file. In general, valid measurements for all patches fall within the range 
of -0.05 to 3.05. 

TO MEASURE CALIBRATION PATCHES WITH AN X-RITE DTP32:

1. When prompted on the Control Panel or Fiery XJ Print Calibrator, position the pointer 
on the strip guide to 15 and click OK on the Control Panel or Fiery XJ Print Calibrator 
to begin measuring.

First, you’ll measure the cyan column. Slide the paper guide left or right until the 
arrow points to 15.
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2. With the arrow below the cyan column pointing towards the densitometer, align the 
right side of the patches page with the strip guide.

3. Insert the patches page into the densitometer until it rests against the drive rollers 
and the motor is activated.

There may be a slight hesitation before the rollers start.

4. Hold the page against the guide to prevent any skewing while the strip is being 
measured.

After the strip is measured, Pass #1 of 4 OK! appears in the densitometer display. 
Transmitting Data appears briefly after each pass.

5. When prompted, move the strip guide to 30 and measure the magenta column.

After the magenta strip is measured, Pass #2 of 4 OK! appears in the densitometer 
display.

6. Turn the patches page around so that the arrow above the yellow column is pointing 
toward the densitometer.

Leave the strip guide set to 30.

7. When prompted, align the right side of the patches page with the strip guide and 
measure the yellow column.

After the yellow strip is measured, Pass #3 of 4 OK! appears in the densitometer 
display.

8. When prompted, move the page guide to 15 and measure the black column.

After the black strip is measured, Pass #4 of 4 OK! appears in the densitometer display.

NOTE: If there is a problem measuring a color, follow the instructions on the 
densitometer to remeasure it.
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Calibrating the Fiery SI from the Control Panel
You can calibrate the Fiery SI from the Control Panel by connecting a densitometer to 
the serial port on the back of the Fiery SI, or by using AutoCal.

Automatic calibration
You can calibrate the Fiery SI without a densitometer with AutoCal.

USING AUTOMATIC CALIBRATION:

1. When the Fiery SI restarts, press the Menu key when prompted to enter Setup.

2. Press Run Setup.

3. Scroll down to choose Calibration.

4. Choose Calibrate.

The Calibration Method screen appears.

5. Select Copier Glass for the Calibration Method.

6. When prompted to Select Target, use the up/down arrow keys to scroll through the list 
of target names, then choose OK.

You can choose from the list of all targets on the Fiery SI hard drive. This includes 
several targets included with the Fiery SI as well as any custom targets you have loaded.

7. When prompted, select Yes to print the Measurements page.

This page is comprised of bands of color that will be measured by the copier and then 
compared to the target calibration.

After the page is printed, the Measure Page screen displays.

8. Select Yes and then choose OK.

9. When prompted “Position page on copier, then press OK,” place the Measurements 
page on the copier glass and click OK.

Position the page as you would a standard portrait copy with the top of the page at the 
far edge of the copier glass. The copier scans the page on the glass, creates a 
measurements table, and automatically compares it to the target you selected. It then 
adjusts measurements to match the target.
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10. When prompted to Print Comparison Page, select Yes.

Verify that the colors on the page are correct.

11. When Prompted to Overwrite Calibration, select Yes.

12. Select Yes to confirm.

13. When calibration is complete, choose Exit Calibration. This automatically restarts your 
Fiery SI.

Calibrating with a densitometer
To calibrate with a densitometer, the Fiery SI must have a serial port to connect the 
densitometer to. Contact your authorized service/support center for information about 
Fiery SI hardware.

TO CALIBRATE WITH A DENSITOMETER:

1. Connect the DTP32 densitometer to your Fiery SI

For instructions, see “Setting up the densitometer” on page 6-4.

2. Restart the Fiery SI and press the Menu key when prompted to enter Setup.

3. Press Run Setup.

4. Scroll down to choose Calibration.

5. Choose Calibrate.

The Calibration Method screen appears.

6. Select Densitometer for the Calibration Method.

7. When prompted to Select Target, use the up/down arrow keys to scroll through the list 
of target names, then choose OK.

You can choose from the list of all targets on the Fiery SI. This includes several targets 
included with the Fiery SI as well as any custom targets you have created from your 
workstation with Fiery XJ Print Calibrator.
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8. When prompted, select Yes to print the Measurements page.

This page is comprised of swatches of color that will be measured by the densitometer 
and then compared to the target calibration.

After the page is printed, the Measure Page screen displays.

9. Select Yes and then choose OK.

10. When prompted on the Control Panel, position the cyan strip in the densitometer.

See “Measuring values with a DTP32 densitometer” on page 6-8 for instructions. 
Status messages display the progress of scanning and collecting measurements. If there 
is a problem, you may need to calibrate your densitometer. See “To calibrate the X-Rite 
DTP32:” on page 6-7.

11. When prompted, repeat step 10 to scan magenta, yellow, and black. 

12. When prompted to Print Comparison Page, select Yes.

This page provides you with a preview of the selected calibration.

13. When Prompted to Overwrite Calibration, select Yes.

14. Select Yes to confirm.

Status messages display progress information.

15. When calibration is complete, choose Exit Calibration. This automatically restarts your 
Fiery SI.
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Removing calibration
If desired, you can remove calibration from the Fiery SI. In general, it is not necessary 
because any new calibration replaces the existing one.

TO REMOVE CALIBRATION USING THE CONTROL PANEL:

1. When the Fiery SI restarts, press the Menu key when prompted to enter Setup.

2. Press Run Setup.

3. Scroll down to choose Calibration.

4. Choose Remove Calibration.

5. When prompted, verify that you want to proceed with removing calibration.

The current calibration curves are removed and the printer is uncalibrated. After 
calibration is removed, you can download a new calibration.

Using the Fiery XJ Print Calibrator
The Fiery XJ Print Calibrator allows you to perform extended calibration procedures 
from your networked workstation. You can calibrate to targets provided with your 
Fiery SI, or you can customize targets and calibration curves to suit the specific needs 
of your printing environment.

NOTE: The utilities for Macintosh and Windows users are fundamentally the same; 
differences are noted in this chapter. When you see a window or dialog box illustrated, 
the Macintosh version comes first, followed by the Windows 95 version.

TO VIEW INFORMATION WITH THE FIERY XJ PRINT CALIBRATOR: 

1. Double-click the Fiery XJ Print Calibrator icon.

The Chooser window appears.

2. Select the Fiery SI in the Chooser window that appears and click Connect or OK.

If there is no Measurements file on the Fiery SI or no Target selected, you will be 
notified during startup.
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The Fiery XJ Print Calibrator main window and File, Edit, Measurements, Server, and 
Window menus appear. Buttons for the main Fiery XJ Print Calibrator functions 
appear in this window. The current status is displayed at the bottom of the window. 
The functions unavailable at a particular time are dimmed and cannot be selected.

The buttons are:

Measurements Displays density values in the current measurements 
file.

Target Allows you to select a new target for calibration or for 
customizing. Displays the currently selected target.
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3. To view current calibration information, choose Calibration Status from the Server 
menu.

The Server Calibration status dialog displays: the user name of the person who last 
calibrated the Fiery SI, the name of the current Fiery SI, the date and time of the 
current measurement file, the file name of the target used for the last calibration, and 
the date and time of the most recent calibration.

4. To calibrate a different Fiery SI, choose Open from the File menu.

Edit Calibration Allows you to view the current measured and target 
curves and customize the selected target.

Test Prints a page so that you can view the results of 
calibration before changing the calibration on the 
Fiery SI.

Apply Calibration Updates the calibration on the Fiery SI.
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Measurements
Measurements files provide toner values that correspond to colors. You can measure a 
page of swatches with a densitometer and import the measurements.

The creation date and time of the current measurements file appears below the 
Measurements icon. If there is no measurements file, see “To create a measurements file 
to be imported:” on page 6-17.

TO USE MEASUREMENTS:

1. Click the Measurements icon to view values in the current measurements file.
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2. If you want to use a different measurements file, choose Import from the 
Measurements menu; if you do not want to change the file, go to the Target section.

3. When prompted, select the new measurements file to use and click OK.

TO CREATE A MEASUREMENTS FILE TO BE IMPORTED: 

1. Connect the DTP32 densitometer to your Macintosh or PC.

2. Choose Densitometer from the Measurements menu.

NOTE: Creating a measurements file from a densitometer connected to your PC is not 
supported with Windows 3.x.
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3. Select the port connected to the densitometer in the Select Densitometer pop-up 
menu.

4. Click Start.

5. Follow the on-screen instructions to measure patches.

For instructions, see “Measuring values with a DTP32 densitometer” on page 6-8.

6. When you are finished, click Accept.

You can save the measurements file so that you can use it again by choosing Export 
from the Measurements menu. This saves the values in the Measurements file that you 
can use later without having to remeasure by importing it.
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Working with targets
Target files are files containing desired calibration goals. Several target files are provided 
with the Fiery SI, and you can create additional ones as needed. You can then select the 
target file that corresponds to the type of printing you are doing.

The text under the Target button in the Fiery XJ Print Calibrator main window 
displays the name and creation date and time for the currently selected target.

TO SELECT A TARGET:

1. Click the Target button in the Fiery XJ Print Calibrator window.

A dialog box displays a list of target files available on the Fiery SI.
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2. If desired, click Local to select a target on your workstation, if not, go to step 3.

3. Select a target and click OK.

TO BACK UP TARGETS:

• Choose Backup Targets from the Server menu to copy the target files on the Fiery SI to 
your workstation. 

Files are saved in a folder called Backup in the Fiery XJ Print Calibrator folder. You can 
save targets for safekeeping. You should always save targets before updating Fiery SI 
system software to ensure that no custom targets are lost.
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TO REMOVE TARGETS FROM THE FIERY SI’S HARD DISK:

1. Choose Remove Target from the Server menu. 

2. Select the target(s) and click Remove.

You may want to do this to free up disk space (although these files are small) and to 
make sure that no one uses the wrong target file. You should always use the Backup 
Targets command to save targets before you delete them.
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Editing calibration
You can edit the current calibration curve or the target file, and save the changes as a 
new target calibration file. This allows you to fine tune the calibration on your Fiery SI 
to meet your exact specifications.

The creation date and time of the current calibration appear under the Edit 
Calibration button.

NOTE: The values in these screens do not represent standard values for calibration. They 
are intentionally exaggerated for example purposes.

TO VIEW TARGET/MEASURED CURVES OR EDIT CALIBRATION:

1. Click the Edit Calibration button.

The Edit Calibration dialog box appears.
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You can use this dialog box to view measured or target curves or to edit calibration 
curves. The graph on the left side of the window allows you to view and manipulate 
color output values; the areas on the right allow you to adjust other values. The View 
Channels and View Curves areas specify which curves display on the graph.

2. In the View Channels area, verify that the channels you want to edit are selected.

You can view the channels for all four color channels (Cyan, Magenta, Yellow, and 
Black), or in any combination. This aids in fine tuning edits and when editing curves 
on a monochrome screen.

NOTE: If all channels are turned on initially, they may overlap so you will have to move 
or turn off the topmost channel to see other channels.

3. In the View Curves area, verify that the curves you want to edit are selected.

Choose Target/Measured to view the target or measured curve; choose Custom to view 
and edit the calibration curves. If you selected Target/Measured, you can use the check 
boxes to specify whether to view Target, Measured, or both curves.
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TO VIEW THE MEASURED CURVE:

• Click Target/Measured and Measured in the View Curves area.

These curves represent the values in the measurements file and cannot be changed.
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NOTE: You can click Target to compare the target curve to the measured curve. The 
closer the measured densities are to the target densities, the better the results you’ll get 
from calibration.

TO EDIT THE TARGET CURVE:

1. Click Target/Measured and Target on the right side of the dialog box.

2. Adjust the values in the Maximum Density areas for each color to adjust the endpoints 
of the target curve as needed.

You can enter a value from 0.1 to 3.0.



66-26 Color Calibration
The rest of the curve adjusts to match the endpoint.
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TO EDIT CUSTOM CURVES:

1. Click Custom to edit the curve.
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2. From the Apply setting to pop-up menu, choose the channels to be adjusted in the 
Lightness/Darkness area of the window.

3. If needed, use the Brightness menu to adjust brightness.

Choose Lightest for a substantially lighter image, Darkest for a substantially darker 
image, or one of the options in between. 

NOTE: If you change a value for a color with the Brightness menu, it overrides values 
set elsewhere in the dialog box.

4. If needed, adjust the Dot Gain value.

This is used for simulating press output and should be used with a press target. You can 
choose either the North American or European standard. Then enter the desired Dot 
Gain in the text box(es). The valid values for North American gain at 50% input are 
0%-50% output. The valid values for European at 40% input are 0%-60% gain on 
output; the valid values for European at 80% input are 0%-20% gain on output.

If you use Dot Gain values, the curve is smoothed so that there are no spikes or jumps 
in output value.

NOTE: You will need to measure this value with a densitometer.
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5. If necessary, in the graph, click and drag points to adjust the curve.

The graph maps input percentage to output percentage in 10% increments. The curve 
you selected appears, and points along the curve are marked so that you can adjust 
them.

NOTE: You should adjust points in this way after you have entered values in the other 
area of the window. If you attempt to change values after you have adjusted the curve 
on the graph, values may not be valid.



66-30 Color Calibration
6. When you are finished, click Save Target and enter a name for the new target.

This saves the target file to your Macintosh or PC hard disk so that you can use it again 
or continue editing it later.

NOTE: If you edited one of the press standard targets, make sure that you include the 
original standard name (SWOP, DIC, Linear, or Euroscale) in the new target name. 
This ensures that the correct information appears on the Calibrator Test Page.

Testing and applying calibration
You can view a sample of calibration before you apply it to your Fiery SI. You can 
print:

• Calibrator Test Page—This page is provided with Fiery XJ Print Calibrator and 
shows a comparison of uncalibrated and calibrated data.

• User defined CALIB.EPS in Hold Queue— You can create an Encapsulated 
PostScript (EPS) file in any application and name it CALIB.EPS. Then print the file 
to the Hold Queue of the Fiery SI from your application or save it as an EPS file and 
download it to the Hold Queue with the Fiery XJ Downloader.
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TO TEST AND APPLY CALIBRATION:

1. Click Test in the Fiery XJ Print Calibrator main window.

2. Specify which page to print and click Print.

3. When you have visually verified that the test page displays appropriate color values, 
click Apply Calibration.

4. Click Continue when prompted to verify that you want to update calibration.

5. When you are finished, choose Quit (Macintosh) or Exit (Windows) from the File menu 
to close the Fiery XJ Print Calibrator application.
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Removing calibration
If desired, you can remove calibration from the Fiery SI. In general, it is not necessary 
because any new calibration replaces the existing one.

TO REMOVE CALIBRATION WITH THE FIERY XJ PRINT CALIBRATOR:

1. Start the Fiery XJ Print Calibrator.

2. Choose Remove Calibration from the Server menu.

3. When prompted, verify that you want to proceed with removing calibration.

The current calibration curves are removed and the printer is uncalibrated. 
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You can print to the Fiery SI directly from UNIX. Jobs printed to the Fiery SI are sent 
to the Print or Hold queue and can be manipulated from Macintosh and PC 
computers on the network.

NOTE: You should print to the Hold queue only if you have a Macintosh or PC with 
Fiery XJ Spooler connected to the Fiery SI, so that you can move the jobs from the 
Hold queue to the Print queue.

The queue name and Fiery SI printer name are established by your system 
administrator. Contact your system administrator for the name of your queues.

NOTE FOR ADMINISTRATORS:The internal rp names that must be matched exactly when 
setting up printing to the Fiery SI are: print_5760/65, hold_5760/65, print_5790, 
hold_5790, print_5750, and hold_5750.

For information about setting up printing from TCP/IP, see your UNIX system 
documentation.

Printing to the Fiery SI
You can use UNIX commands to print PostScript files and text files to the Fiery SI. In 
general, the basic printing commands (lpr, lpq, lprm) can be used to send print jobs to 
a Fiery SI. See your UNIX manual pages or other documentation for information 
about UNIX commands.

NOTE: Make sure that the files are either PostScript or text files. These are the only 
formats you can use to print from UNIX. 

Chapter 7:
Printing 
with UNIX 
Workstations
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TO PRINT FROM UNIX:

• On a system running SunOS4 or another BSD-based variant, use the lpr command to 
send a job to the Fiery SI as follows:

lpr <-Pprinter> <-#copies> <filename>

For example, if the Print queue of your Fiery SI is named print_Server, your file is 
named Sample, and you want to print two copies, type:

lpr -Pprint_Server -#2 Sample

• On a system running Solaris 2 or any System V implementation of UNIX, use the lpr 
command to send a job to the Fiery SI as follows:

lp -d <printername> {-n <-#copies>} <filename>

For example, if the Print queue of your Fiery SI is named print_Server, your file is 
named Sample, and you want to print two copies, type:

lp -d print_Server -n 2 Sample

TO DISPLAY A LIST OF JOBS IN THE QUEUE:

• On a system running SunOS 4 or another BSD-based variant, use the lpq command to 
see printer jobs in the queue as follows:

lpq <-Pprinter>

For example, if the Print queue of your Fiery SI is named print_Server, type:

lpq -Pprint_Server

Your workstation displays the contents of the queue.

• On a system running Solaris 2 or any System V implementation of UNIX, use the lpstat 
command to see printer jobs in the queue as follows:

lpstat -o <printername>

For example, if the Print queue of your Fiery SI is named print_Server, type:

lpstat -o print_Server

Your workstation displays the contents of the queue.
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TO REMOVE JOBS FROM THE QUEUE:

NOTE: Unless you log in as the root user, you can remove only your own jobs. 

• On a system running SunOS 4 or another BSD-based variant, use the lprm command to 
remove jobs from the queue as follows.

lprm <-Pprinter> <job #…>

You can use the lpq command to check the job number.

For example, to remove job number 123 from the Print queue of your Fiery SI named 
print_Server, type:

lprm -Pprint_Server 123

The lprm command reports the names of any files it removes.

• On a system running Solaris 2 or any System V implementation of UNIX, use the cancel 
command to remove jobs from the queue.

cancel <printername> <job ID>

For example, to remove job number 123 from the Print queue of your Fiery SI named 
print_Server, type:

cancel print_Server 123
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When an error interferes with printing, you will see a message on the Fiery SI Control 
Panel. Following are the messages (listed in alphabetical order), with the appropriate 
corrective action for each one.

Message Corrective action/additional information

Accessory disabled One of the copier’s accessories is disabled.

Busy The Fiery SI has received a print job, but the copier is 
busy. The job will print when the copier resumes printing.

Check power & cable There is a problem with the copier power or cable 
connection. First check to make sure that the copier is 
turned on. There may also be a problem with the cable 
connection between the Fiery SI and the copier. Make sure 
that the cable has not come loose. The Fiery SI will resume 
printing when the cable is securely connected to both the 
Fiery SI and the copier.

Copier needs attn There is an unidentified problem with the copier. See the 
copier user interface for additional messages. The copier 
will resume printing when the problem is corrected.

Copier offline The Suspend Printing option has been selected from the 
Function menu. Press Resume Printing in the Functions 
menu to reconnect the Fiery SI to the copier. 

Copier running The copier is in use scanning or making a copy. 

Disk full The internal Fiery SI hard drive is full. To make more 
space available, open the Fiery XJ Spooler and delete 
unnecessary jobs or use the Fiery XJ Downloader to 
remove unnecessary fonts. If these do not work, you can 
use the Clear Server command from the Control Panel.

Door open One of the doors on the copier is open. Close the door to 
resume printing.

Fuser web empty The copier’s fuser web is empty. Printing will resume when 
it is replaced.

Appendix A: 
Error Messages
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Ld ___ in bypass The copier’s bypass tray is not loaded with the paper size 
specified. The Fiery SI will print when the bypass tray is 
loaded with the required paper.

Ld ___ trans bypass The copier’s bypass tray is not loaded with the 
transparency size specified. The Fiery SI will print when 
the bypass tray is loaded with the required transparency.

Load ___ paper The copier is not loaded with the paper size specified. The 
Fiery SI will print when the copier is loaded with the 
required paper. This message will also appear if you are 
printing transparency interleave and do not have the 
correct paper size loaded.

Ld ___ in tray 1 The copier’s tray 1 is not loaded with the paper size 
specified. The Fiery SI will print when tray 1 is loaded 
with the required paper.

Ld ___ in tray 2 The copier’s tray 2 is not loaded with the paper size 
specified. The Fiery SI will print when tray 2 is loaded 
with the required paper.

Ld ___ in tray 3 The copier’s tray 3 is not loaded with the paper size 
specified. The Fiery SI will print when tray 3 is loaded 
with the required paper.

No toner The toner for one of the colors has run out. Refer to the 
copier display to determine which toner color is empty. If 
more than one toner needs to be added, press and hold the 
Stop icon on the copier for additional information.

Paper jam There is a paper jam in the copier. Open the copier doors 
and check the locations indicated on the copier display. 
The Fiery SI will resume printing when you have cleared 
the paper jam and closed the copier doors.

Press “Clear All” Press the Clear All button on the copier.
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Replace waste bottle The copier waste toner container is full of used toner. 
Replace the container with a new one according to the 
instructions in your copier manual. The Fiery SI will 
resume printing when you have replaced the waste toner 
container.

Reset copier & XJ Press the Reset button on the copier and then select the 
Reboot Server option in the Functions menu to reset the 
copier and Fiery SI.

Sorter limit exceeded The sorter is full. You must remove the paper in the sorter 
before continuing the job.

Sorter problem There is a problem with the copier’s sorter. See the copier 
console for instructions.

Unknown error An error occurred with the copier. See the copier message 
panel for information.

Warming Up The copier is powering up. It will be ready for printing in 
a few minutes.
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Times 

ABCDEFGHIJKLMNOPQRTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890 

Helvetica

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

Helvetica Narrow

ABCDEFGHIJKLMNOPQSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

Helvetica Condensed

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

ITC Avant Garde

ABCDEFGHIJKLMNOPQRSTVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

Palatino

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

ITC Bookman

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

Appendix B: 
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New Century Schoolbook

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

ITC Zapf Dingbats

✡✢✣✤✥✦✧★✩✪✫✬✭✮✯✰✱✲✳✴✵✶✷✸✹✺
❁❂❃❄❅❆❇❈❉❊❋●❍■❏❐❑❒▲▼◆❖◗❘❙❚

ITC Zapf Chancery

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890

Symbol

ΑΒΧ∆ΕΦΓΗΙϑΚΛΜΝΟΠΘΡΣΤΥςΩΞΨΖ
αβχδεφγηιϕκλµνοπθρστυϖωξψζ

Courier

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz1234567890
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C-1 Troubleshooting

 

This section provides some troubleshooting guidelines should a problem arise. If you 
are still unable to resolve a problem, contact your authorized service/support center. 

 

Basic troubleshooting tips

 

There are some basic situations that can cause a variety of problems. Before you look 
for a specific problem, use the tips in this list.

 

1. Check the power and cables for your Fiery SI, copier, and computer.

2. Check the Control Panel and Activity Light of the Fiery SI for information.

3. If possible, print the Configuration page from the Control Panel and make sure that the 
settings match your configuration.

4. Check the current status of the Fiery SI.

 

The current status appears on the Fiery SI control panel. Press the Menu button to see 
other status screens. For example, if there is a job processing and one printing, you can 
press the Menu button to view status information about both jobs.

If you have the Background Printing option turned on in the Chooser on a Macintosh 
computer, open Print Monitor to see the printing status. If the status messages indicate 
that Fiery SI is “processing” or “printing” your file, the Fiery SI is still working on your 
job. In general, you should turn Background Printing off with the Fiery SI.

In the Fiery XJ Downloader, check the Status window, or look at the Status field in the 
Fiery XJ Spooler main window. If the Fiery SI is processing your job, you’ll see this 
from the status message. If your print job doesn’t appear in the status message, another 
user’s job may be printing before yours, or the Fiery SI may already have finished 
printing your job. If the Printed queue on your Fiery SI is enabled, jobs that have 
finished printing will appear in that list in the Fiery XJ Spooler main window. If your 
job is waiting to print, it will appear in the list for the Print queue.

If you are printing over an IPX (Novell) network, the job may be processing on the 
Novell print server before it is sent to the Fiery SI.

 

5. Open the Fiery XJ Spooler main window and locate the name of the job you are trying 
to print. 

 

This window provides information about the status of every job printed to a queue, 
including information about jobs that do not print because of PostScript errors.

Appendix C: 
Troubleshooting
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C-2 Troubleshooting

 

General printing problems

 

If this happens: Try this:

 

The Fiery SI doesn’t appear in 
the Macintosh Chooser’s list of 
printers

 

1. On the Macintosh, make sure that the correct zone is selected and that AppleTalk is 
active.

 

AppleTalk must be active. The Fiery SI may be in a different zone from the one that’s 
selected. (If your network doesn’t have zones, this is not applicable.) Print the 
Configuration page from the Control Panel to view the correct AppleTalk zone.

 

2. Choose Control Panels from the Apple menu, open the Network Control Panel (or 
AppleTalk Control Panel), and make sure that you have selected EtherTalk Phase 2.

 

You will see icons identifying the available network types. If your Macintosh has Built-in 
EtherTalk, it is EtherTalk Phase 2.

 

3. Does the Fiery SI appear in the Chooser on another Macintosh on the same network?

 

If there’s another Macintosh nearby, check to see if the Fiery SI appears in the Chooser 
on that Macintosh. If the Fiery SI is visible from one Macintosh, but not from another, 
there may be a problem with the way the second Macintosh is connected to the 
network. Check all the cabling and other connections, and verify that the network is 
properly terminated. If there is a 10BaseT transceiver on the network, make sure that its 
green link integrity light is on. For more information about the network, refer to the 
documentation provided with the network hardware. 

 

4. Do other printers on the network appear in the Chooser?

 

If your network includes printers other than the Fiery SI, they should appear in the 
Chooser. If none of the printers appear in the Chooser list, there is most likely a problem 
with the way the Macintosh is connected to the network. Check all the cabling and 
other connections. For more information about the network, refer to the documentation 
provided with the network hardware.

If other printers appear in the Chooser, there may be a problem with the Fiery SI 
connection. Contact your Fiery SI system administrator.

 

5. Try printing a test page by pressing the Menu button and choosing Print Pages/Test Page 
from the Control Panel.

 

If you’re able to print the test page, but Fiery SI still does not appear in the Chooser, 
contact your authorized service/support center. 
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You cannot connect to a 
Fiery SI from a Fiery XJ utility 
chooser

 

• Make sure that no one is calibrating the Fiery SI.

 

If someone is calibrating the Fiery SI with the control panel or the Fiery XJ Print 
Calibrator, you can select it in the Chooser, but you cannot connect to it. This insures 
that only one person is calibrating the server at any time and that print jobs do not use 
unexpected calibration.

You cannot select or view one 
of the queues

 

• Have your system administrator enable the queue in Setup on the Fiery SI Control Panel. 
Only connections enabled in Setup are available for selection and display in the Fiery XJ 
Spooler.

 

You cannot open the Fiery SI 
with the Chooser in a Fiery SI 
Windows utility

 

• If you are using Windows 3.x, you may not have enough Conventional memory to open 
the Fiery Chooser.

 

See your Windows documentation for information about memory.

 

• If you are using Windows 3.x with AppleTalk, did you set up your AUTOEXEC.BAT files in 
the proper order?

 

If Windows quits unexpectedly, or if you receive an error message, “Cannot perform 
AppleTalk call,” and you are using COPSTalk, you may have put the Fiery SI Network 
Setup commands in the wrong order in your AUTOEXEC.BAT file. Check to make 
sure that any COPSTalk commands

 

 precede

 

 the APPL_TSR and APPLINIT commands, 
so that all network information is loaded first.

See 

 

Getting Started

 

 and the documentation that came with your network software for 
more information.

 

• If you are using Windows 95 or Windows NT, is your NET_WSCK.INI file set up correctly?

 

This file must be set up for Windows 95 and Windows NT printing with TCP/IP and 
SPX/IPX. See 

 

Getting Started

 

 for instructions.

Printing seems to take too 
long

 

• Print to a queue instead of to the direct connection.

 

When you print to a queue, the job is stored on the Fiery SI until it can be processed 
and printed; when you print to the direct connection, some file processing is performed 
on your computer before it is sent to the Fiery SI and it cannot begin processing on the 
Fiery SI until it is done processing the previous job, so you must wait longer to use your 
computer.

Special paper or transparency 
options are grayed out

 

• Select a tray that supports printing special paper or transparencies such as the 

 

Bypass 
Tray

 

.

 

If this happens: Try this:
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Fiery SI doesn’t respond to a 
Print command

 

• Has someone disconnected the copier by selecting Suspend Printing?

 

If the Fiery SI system administrator or another user has selected 

 

Suspend Printing

 

 on the 
Fiery SI Control Panel to interrupt printing (so that someone can make a color copy, for 
example), your print job will not resume until someone selects 

 

Resume Printing

 

 from the 
Functions menu on the Control Panel.

 

• Did you select the Fiery SI as the current printer?

 

Before printing, you must select the Fiery SI as the current printer from your 
Macintosh, IBM PC or compatible, or UNIX workstation.

 

• Is the Fiery SI visible in the Chooser on your Macintosh?

 

If not, see the topic, “The Fiery SI doesn’t appear in the Macintosh Chooser’s list of 
printers” on page C-2.”

 

• Make sure that the copier is switched on.

 

Someone may have turned the copier off, or the Automatic Power-Off or Power Saver 
mode function may have engaged. Even with the copier off, the Fiery SI appears in the 
Chooser as long as the Fiery SI itself is turned on. 

 

• Try printing a test page by pressing the Menu button and choosing Print Pages/Test Page.

 

If you’re able to print the test page but still can’t print a file from your computer, contact 
your system administrator or your authorized service/support center.

 

• Verify that you printed to the correct queue.

 

View the Fiery XJ Spooler main window to see which queue you printed to. If you 
selected the Fiery SI Hold queue, you must move your job to the Print queue to print. 

 

• If you are printing over an IPX (Novell) network, verify through PCONSOLE that the job 
was sent to the Novell queue and that the queue is being used by the Fiery SI.

• Make sure that the job does not contain a PostScript error.

 

In Setup, turn on the Print up to PostScript error option to search for PostScript errors 
in the file. In the Fiery XJ Spooler, check to see if the job has an error icon next to it. 
Double-click the icon to see the PostScript error message.

 

If this happens: Try this:
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Message requests a paper size 
that you don’t have

 

• Cancel the job and do one of the following:

 

If you are printing a PostScript file, set the Convert Paper Sizes setting in Printer Setup 
on the Control Panel to convert the job to the paper size you do have. You can do this to 
convert between US and metric paper sizes. See the 

 

Administrator Guide

 

 for 
information.

If you are printing a file from an application, change the page size in the Page Setup 
dialog box.

Test page or other special 
Control Panel page doesn’t 
print

 

1. If the message “Ripping” displays on the Control Panel, but the page never prints, 
restart the Fiery SI, press the Menu button to enter Setup, and verify that the Printer 
Model in Printer Setup is specified correctly.

2. Check the copier’s display.

 

If the copier display says 

 

Ready to copy

 

, proceed to step 3.

If the display shows a diagnostic or error message, take the appropriate corrective action, 
as described in the copier manual.

 

3. Try making a copy.

 

If you can make a copy, proceed to step 4.

 

4. Restart the Fiery SI, and when you see Idle on the status line of the Fiery SI display, try 
printing a test page again. 

 

If the test page still fails to print, contact your authorized service/support center.

 

If this happens: Try this:
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Jobs sent to the parallel port 
do not print

 

• Increase the parallel “Port Timeout in Seconds” on the Fiery SI Control Panel 

• On the Fiery SI Control Panel, change the Ignore EOF Character setting.

 

If you are printing ASCII format PostScript only, set 

 

Ignore EOF Character

 

 to No.

If you are printing Binary format PostScript, set it to Yes.

 

• If you print using the DOS 

 

copy

 

 command, make sure to use the 

 

/b

 

 option when printing 
binary files.

• Restart your PC, enter BIOS setup, and if you have a BIOS setting for the parallel port, 
make sure that it is set to Compatible mode and not to Bi-Directional, ECP, EPP, or any 
other mode.

• If you are using Windows 95, open the System Properties control panel, click the Device 
Manager tab, click Ports, double-click the parallel port you are using, and make sure that 
the driver selected is the standard Printer Port driver instead of the ECP Port, EPP Port, 
or any other driver. 

 

For information about changing this setting, see your Windows 95 documentation.

 

• If the PostScript Printer Driver that you are using lets you select bi-directional 
communication, make sure that it is disabled. 

 

This is generally set from the Properties dialog box for the printer. 

 

If you are printing 
from a DOS window on a Windows 95 PC, display the Properties dialog box for the 
printer, click the Details tab, and then click Port Settings. In the Configure LPT port box 
that displays, turn the “Spool MS-DOS print jobs” option off. 

 

If this happens: Try this:
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Problems with print quality

 

.

 

If this happens: Try this:

 

Print settings for your job 
output do not match the 
settings you gave

 

• Make sure that you did not override the setting for the job in another place.

 

For information about options and overrides, see Appendix D "Setting Job Overrides."

You get poor printing results

 

• Does your application require the Fiery SI’s printer description files?

 

If you are printing from an application such as Adobe Separator or PageMaker, 
MacroMedia FreeHand, or QuarkXPress, you should make sure that the Fiery SI printer 
description file is installed correctly. For information about installing these files, see 
Getting Started.

 

• Calibrate your copier.

 

Separations do not combine 
properly

 

• Make sure that the file was initially created as separations.

• If you are printing separations or a DCS format file, check the Combine Separations 
setting for the job in the Print Options (Macintosh) or Features (Windows) dialog box.

 

With Combine Separations On, all four colors will be printed on a single page; with 
Combine Separations Off, four black-and white pages will print to simulate four single-
color plates.

The registration or colors of an 
image are not what you 
expected

 

• Print a test page or make a test copy with the copier.

 

The problem may be with the copier. If your test page or copy show that the copier is 
working properly, correct the problem within your application software. If the test page 
or copy are wrong, your copier may need to be calibrated or adjusted in some other way. 

Your printed file appears too 
dark

 

• Adjust the image’s Brightness setting in the Print Options (Macintosh), Print Features 
(Adobe PostScript Printer Driver for Windows), Device Options (Windows 95 PostScript 
Printer Driver), Download (Fiery XJ Downloader), or Override Print Settings (Fiery XJ 
Spooler) dialog box.

 

You can use the Brightness options in the Fiery XJ Downloader to adjust the lightness of 
your image whenever you print a PostScript or Encapsulated PostScript (EPS) file. 
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C-8 Troubleshooting

 

Color output is incorrect

 

• Print the Configuration page and check the calibration information. 

 

The copier may need to be recalibrated because it has been too long since it was 
calibrated or because it is using a different target. You should use the copier target if you 
are going to use ICC ColorSync or ICM profiles, the color rendering styles available in 
the Print Options and Features and Fiery XJ Spooler Overrides dialog boxes, the 
Fiery XJ Scan Match Copy color conversion, or the Photoshop separation tables.

Color file prints in black and 
white

 

• Print the Configuration page and make sure that the Color Mode is set to CMYK and not 
Grayscale.

• In the Print dialog box (or Print Options), make sure that you have not selected Black 
and White.

• Make sure that the Color Mode selected for the job in the Print Options or Print Features 
dialog box is CMYK and not Grayscale.

 

Desktop Color Separations 
(DCS) format images print 
incorrectly

 

1. Make sure that you selected the correct options to send separations in the application’s 
Print dialog box.

2. Make sure that you have the file for every layer of separation that you are printing.

3. Set the Combine Separations option to On in the Print Options or Print Features dialog 
box.

 

This combines the high-resolution files for an image and prints them. With Combine 
Separations Off, the low-resolution master file will print.

QuickDraw fill patterns print 
as solids

 

• Use the Adobe PostScript Printer driver (Or the Apple LaserWriter 8.1 or later printer 
driver).

 

If this happens: Try this:
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C-9 Troubleshooting

 

Problems with calibration

 

If you are calibrating from the Fiery SI, check the Control Panel for an error message.

 

If this happens: Try this:

 

After calibration, the toner 
density for a particular color is 
too high

 

• Open the Edit Calibration window and adjust the maximum density for that color.

 

A measurement is out of range

 

• Make sure you have properly zeroed your densitometer.

 

After calibration, dark patches 
on the test page are too 
saturated or too weak

 

• If the colors are too weak, check the toner level.

• Check to see if your densitometer needs calibration.

• Make sure that you’re using the correct target.

 

Nothing happens when you 
press down on the 
densitometer unit

Your densitometer may have locked up. The solution is to clear the unit’s memory.

 

1. Disconnect the densitometer from its power supply.

2. Remove the batteries from the unit for a minute.

3. Calibrate and zero your densitometer before continuing.

 

The DTP32 densitometer 
displays “Transmitting Data,” 
but no data is transmitted. The 
densitometer appears stuck or 
frozen

A data transmission error may have occurred.

 

1. On the X-Rite DTP 32, press the two keys marked 

 

MENU

 

.

2. On the densitometer, press “pap.”

3. Remeasure the patches.

 

Calibrator Comparison page 
looks wrong

 

• If you are using a custom target for a press standard, make sure that the name of the 
press standard is included in the target name.

 

The Comparison page uses different images to correspond to different targets, so if you 
edit the name of the target for a press standard, you must include the name of the 
standard. Otherwise, the Fiery XJ Print Calibrator prints the images for the copier 
target.



 

CC-10 Troubleshooting

Problems with Fiery XJ utilities and plug-ins

Error message appears on 
control panel

• The numbered error messages (Error Type: 8 and Error Type: 11) have the following 
meanings:

Error Type 8
Description—Page did not scan, incorrect page on copier glass. 
Action—Make sure that you are using the AutoCal file and that it is placed correctly on 
the copier glass. If you still get this message, try scanning a page with Fiery XJ Scan to 
verify that the scan feature is working.

Error Type 11
Description—Data not consistent 
Action—There is a problem with the copier’s scan feature so that the copier can scan the 
page, but it cannot be used to calibrate the Fiery SI. 
Try re-positioning the measurement page on the copier glass or try printing another 
measurement page and placing it on the copier glass.
If you still encounter this error message, there may be a problem with print quality. 
Have your copier serviced.

General problem with: Try this:

Fiery XJ utilities • Make sure that you are using the latest version of utilities.

When you update your Fiery SI to new system software, you should delete the utilities 
on your Macintosh or PC-compatible and install the latest Fiery XJ utilities to insure 
full compatibility.

• If you are using Windows, make sure that additional files are installed correctly.

If you are using Windows, you need additional files to use the utilities and plug-ins. See 
Getting Started for installation instructions and troubleshooting information.

Windows 95 or NT utilities 1. Make sure that either the NET_WIPX.DLL (Windows 95) or NET_WSCK.DLL (Windows NT) 
file is in the SYSTEM directory.

Make sure that only one file is installed in this directory and that it is the correct file for 
your system. 

If this happens: Try this:



CC-11 Troubleshooting

Fiery XJ Downloader problems

If his happens: Try this:

You can’t print an EPS file 
using the Fiery XJ 
Downloader

• Try printing using the “Showpage” option in the Download PostScript File dialog box.

The Showpage (after EPS file) option adds a “showpage” PostScript language command 
at the end of the print job. Certain applications omit this necessary PostScript language 
command when they generate EPS files. You’ll need to select the Append Showpage 
option when printing EPS files generated by these applications.

If you continue having difficulties printing an EPS file with the Fiery SI Downloader, 
try printing the file from the application in which it was created.

• Try printing the EPS file on the media in the manual feed tray.

• Make sure that the job does not contain a PostScript error.

In Setup, turn on the Print up to PostScript error option to search for PostScript errors 
in the file.

In the Fiery XJ Spooler, check to see if the job has an error icon next to it. Double-click 
the icon to see the PostScript error message.

You have problems 
downloading a font with 
Fiery XJ Downloader

• Make sure that the Direct connection is enabled on the Control Panel.

You can print the Configuration page from the Control Panel to see which connections 
are enabled

Extra blank page prints after a 
Fiery XJ Downloader job

• Turn off the “Showpage” option.

This option adds a special PostScript command that will cause an extra blank page to 
print if it is not needed.



CC-12 Troubleshooting

Fiery XJ Scan problems

If this happens: Try this:

Fiery XJ Scan does not appear 
in the Adobe Photoshop 
Acquire menu

• Make sure that the plug-in is installed correctly in the Photoshop Plug-ins folder. For 
information on where to install software, see Getting Started.

• In Photoshop, choose Preferences/Plug-ins from the File menu and verify that the Plug-
ins folder selected corresponds to the folder containing the Fiery XJ Scan.

Fiery XJ Scan images are 
wrong

• Verify that the Printer Model in Printer Setup is specified correctly.

For example, if MajestiK is selected and you are using a Regal, the scan will appear to be 
yellow only.

• Make sure that the Color Conversion setting in the Scan Options dialog box is set 
correctly. 

It should only be set to Match Copy if you are going to scan the file and then print it on 
the same device. You should select Calibrated RGB if you are going to use EFICOLOR 
or manipulate the file in any way or print it on any other device. 

Make sure that it is set to Calibrated RGB if you will be saving the file as an RGB format 
EPS file and placing it in another application, or if you are going to use the EFICOLOR 
profile to print CMYK data separated for your specific copier or the Color Rendering 
Dictionaries (CRDs). 

The CRDs are used if you print a CMYK file from Photoshop, an RGB file with a 
PostScript Level 2 Printer Driver (Adobe PostScript Printer Driver for Macintosh, 
Adobe PostScript Printer Driver for Windows, or Apple LaserWriter Printer Driver 
version 8.0 or later), or if you use a PostScript Level 2 Printer Driver and select Color 
Matching and your Printer Profile in the Print dialog box. If the Fiery SI is calibrated to 
a press standard, select Calibrated RGB, convert the file to CMYK mode in Photoshop, 
and print it in CMYK mode.

• Make sure that the Original option in the Scan Options dialog box is set correctly.

If there is an interference pattern (moiré), select Offset Print or Copy for the 
Resampling setting.

• Make sure that the copier is calibrated to the standard for your copier (and not to a 
press standard, for example).

Print the Test Page from the Control Panel to view the current calibration.

Fiery XJ Scan does not 
respond when you click 
Prescan

• The Fiery SI may be in use by another user. Check the status of the Fiery SI, and try 
again after the job is finished printing.



CC-13 Troubleshooting

Fiery XJ Spooler problems

Fiery XJ Scan does not let you 
scan at full resolution

• Click Prescan and then set the resolution.

The Fiery SI scans at full resolution for an area that is about 25 square inches. When you 
select an area smaller than about 25 square inches, the Max value increases in the dialog 
box, and you can set a higher resolution.

If this happens: Try this:

You can’t move or delete jobs 
in the Macintosh Fiery XJ 
Spooler 

• Choose Password from the Administrator menu and enter the password that was created 
on the Fiery SI Control Panel. If you do not enter the password, you can only move, 
override settings for, and delete your own jobs.

If this happens: Try this:
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D-1 Setting Job Overrides

 

Job Override settings enable you to use all the special features of your copier and 
Fiery SI. You can set job settings in several places. This table shows where options can 
be set and where they can be overriden. The underlined option in the leftmost column 
is the printer’s default. The settings to the right override one another in the order 
given.

For example, Fiery XJ Spooler settings override Fiery XJ Downloader settings, Fiery XJ 
Downloader settings override Print dialog box settings, and so on.

To change settings on the Fiery SI Control Panel, restart the Fiery SI and choose Run 
Setup. For detailed instructions, see the 

 

Administrator Guide

 

. 

 

For information about your Fiery SI’s current settings, choose 

 

Print Pages/
Configuration 

 

from the Functions menu on the Control Panel. The Configuration 
page lists all current settings.

If you are using a printer driver that supports PostScript Level 2, you can set and 
override some options from the Print dialog box and other dialog boxes. The options 
are the same regardless of the name of the dialog box. See Chapter 2 "Printing with 
Macintosh Computers" and Chapter 3 "Printing with PC-Compatible Computers" for 
information about which dialog box to use with your system and how to use them. To 
set options in the Print and Print Options (Macintosh), or Device Options or Print 
Features (Windows) dialog boxes, open the file in an application and follow the 
instructions in Chapters 4 and 5.

To change options in the Fiery XJ Downloader, select the job in the Files to be 
Downloaded list and click Options to display the Options dialog box. For information 
about the Fiery XJ Downloader, see “Downloading files and fonts” on page 5-1.

To change options in the Fiery XJ Spooler, select the job and double-click to display 
the Override Print Settings dialog box. For information about the Fiery XJ Spooler, see 
“Changing print settings for a job” on page 5-20.

Appendix D: 
Setting Job 
Overrides
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D-2 Setting Job Overrides

 

Setting and options
(Underlined option is printer’s 

default)
Description

Control 
Panel

Print 
dialog 
box

Print 
Options/

Print 
Features

Fiery XJ 
Downloader 

Options

Fiery XJ 
Spooler 

Overrides

 

Brightness
85% Lightest/90% Lighter/
95% Light/100% Normal/
105% Dark/110% Darker/
115% Darkest

 

Select 

 

85%

 

 for a substantially 
lighter image, 

 

115%

 

 for a 
substantially darker image, or one 
of the options in between.

No No Yes Yes Yes

 

Bypass Tray
On/Off

Enable Bypass Tray as default
On/Off 

 

(Control Panel)

Specify that the job should be 
printed on the media in the 
Bypass Tray.

Yes Yes No No Yes

 

Color Mode
CMYK/Grayscale

 

Specify the color mode for the 
document. Select 

 

CMYK

 

 if it is a 
full-color document or select 

 

Grayscale

 

 if it is a grayscale 
document.

Yes No Yes No No

 

Copier Mode
Photo/Map

 

This option allows you to specify 
the document type. Select 

 

Photo

 

 
if the file is a photograph; select 

 

Map

 

 if the file is a combination 
of text and photographs. 

No No Yes No No

 

Copies

 

Specify the number of copies of 
the job to print.

No Yes No Yes Yes
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D-3 Setting Job Overrides

 

Media Type
Plain Paper/Thick Paper/
Transparency/Interleaved

 

Use this option to specify the 
type of media to be printed on. 
Select 

 

Plain Paper 

 

if you will be 
printing on standard copier 
paper. Select 

 

Thick Paper 

 

if you 
will be printing on heavy paper 
stock. Select 

 

Transparency

 

 if you 
will be printing on a 
transparency. Select 

 

Interleaved 

 

if 
you will be printing multiple 
transparencies with blank paper 
separators. 

The transparencies are fed from 
the bypass tray and the paper sep-
arators are fed from the paper 
tray. 

The 

 

Transparency 

 

option is 
available only if the source that 
you selected for the Paper Source 
supports Transparency media.

No No Yes No Yes

 

Setting and options
(Underlined option is printer’s 

default)
Description

Control 
Panel

Print 
dialog 
box

Print 
Options/

Print 
Features

Fiery XJ 
Downloader 

Options

Fiery XJ 
Spooler 

Overrides
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D-4 Setting Job Overrides

 

Rendering Style
Photographic/Presentation/
Monitor/Solid Color

 

For more information on this 
setting, see page D-5.

The 

 

Photographic

 

 CRD 
optimizes the range of colors on 
the Fiery SI to produce the best 
results for photographic or 
bitmapped images. The 

 

Presentation

 

 CRD optimizes the 
output of pure, saturated colors 
such as those used in business 
presentations. The 

 

Monitor

 

 
CRD simulates relative color 
values as viewed on a monitor as 
much as possible. Color 
saturation is reduced so that 
colors that are bright on screen 
and have high contrast with other 
colors (especially blues and 
greens) retain those qualities 
when printed. The 

 

Solid Color

 

 

 

CRD is most useful for printing 
spot colors such as those found in 
company logos or corporate 
charts and graphs.

No No Yes No Yes

 

Sharpness
Softer/Default/Sharper

 

Change the Sharpness setting to 
alter the results of a print. Select 

 

Sharper

 

 to make edges appear 
more defined; select 

 

Softer

 

 to 
make edges less defined.

No No Yes No Yes

 

Sorter Mode
On/Off

Enable Sorter as default
On/Off

 

 (Control Panel)

If your copier is equipped with a 
sorter, you can use this option to 
specify that the Fiery SI should 
print the job to the sorter. Only 
20 copies can be printed and 
sorted.

Yes No Yes No Yes

 

Setting and options
(Underlined option is printer’s 

default)
Description

Control 
Panel

Print 
dialog 
box

Print 
Options/

Print 
Features

Fiery XJ 
Downloader 

Options

Fiery XJ 
Spooler 

Overrides
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D-5 Setting Job Overrides

 

Rendering Style

 

Use this setting to select a default color rendering dictionary (CRD) to be used when 
you print an RGB file from the Adobe PostScript Printer driver or an application such 
as Adobe Photoshop 2.5 (or later) that supports PostScript Level 2. 

 

N

 

OTE

 

:

 

Color rendering dictionaries are not used when CMYK files are sent to the 
Fiery SI, nor are they used when RGB files are sent from PostScript Level 1 
applications when using any printer driver or QuickDraw applications when using the 
LaserWriter 7.x or other PostScript Level 1 printer drivers.



IndexIndex

A
activity light on Control Panel 1-2
Adobe Font Downloader 5-1
Adobe Photoshop xiii, xiv

transfer functions 5-7
Adobe PostScript Printer Driver

Macintosh 2-1
Windows 3-2

ADOBEPS.DRV 3-2, 3-3, 3-6
Adobe Type 1 fonts 3-8
Advanced Options dialog box, Windows 3-8
Alert Status screen 1-3
All Colors to Black option 3-8
AppleTalk 2-1
AutoCal 6-10
AUTOEXEC.BAT file C-3
automatic calibration 6-10
automatic paging 5-25

B
Background Printing 2-1
Brightness option

in Fiery XJ Downloader 5-7
in Macintosh Print Options dialog 

box D-2
buttons, Control Panel 1-2
bypass tray 2-4, 3-14

C
CALIB.EPS file 6-30
Calibrated RGB option 4-5
calibration

control panel 6-10, 6-11
custom curves 6-27
editing 6-22
measurements files 6-2
problem with out-of-range values C-9
removing 6-13, 6-32
scheduling 6-3
target files 6-2
understanding 6-2
cancel
downloading 5-7
printing 1-3, 5-15
processing 1-4, 5-15
scanning 4-5

Chooser, Macintosh 2-1, C-2
cleaning server xiii
CMYK Color Reference pages

Macintosh 2-5, 2-6
Windows 3-15, 3-16

CMYK Reference.ps file 2-6
CMYK—REF.ps file 3-16
color, problems C-8
Colorchart.ps file 2-6
Color Charts pages

Macintosh 2-6
printing from LCD 1-5
Windows 3-16

color control (Windows 95) 3-13
Color Conversion option in Fiery XJ 

Scan 4-5
Color Mode option D-2
Color Reference pages

Macintosh 2-5
Windows 3-15

color rendering dictionaries
see Rendering Style option

Configuration page, printing 1-5
Confirm file deletion option 5-17
Control Panel

calibration 6-10, 6-11
server 1-1
status messages 1-3

Control Panel Map, printing 1-5
Copier Mode option D-2
copies, specifiying D-2
copying jobs in Fiery XJ Spooler 5-19
CRDs

see Rendering Style option



I-2 Index
D
deleting jobs in Fiery XJ Spooler 5-20
densitometer

for calibration 6-11
problems C-9
using 6-4

Device Options tab in Windows 95 3-11
diagnostics 1-6
DIC target 6-3
display window 1-3
downloading files and fonts 5-1
duplicating jobs in Fiery XJ Spooler 5-18

E
editing calibration 6-22
EFICOLOR 4-5
Enable Bypass Tray as default option 2-4, 

3-14, D-2
Enable sorter as default option D-4
Encapsulated PostScript File option 3-7
end-of-file (EOF) character 3-2
EPS files 5-1, C-11
error messages, Control Panel A-1
Euroscale target 6-3

F
Features window 3-5
Fiery XJ Downloader

choosing a printer 5-4
printing with 5-4

Fiery XJ Print Calibrator 6-13
Fiery XJ Scan

problems C-12
Fiery XJ Spooler

automatic paging 5-25
changing print settings 5-20
copying jobs 5-19
deleting jobs 5-20
duplicating jobs 5-18
moving jobs 5-19
preferences 5-16
problems C-13
font list
displaying 5-3, 5-11
printing 1-5, 5-3, 5-11

Format Disk option 1-8
For software update or setup press any key 

message 1-7
Functions menu 1-4

G
Graphics tab in Windows 95 3-12

H
Hold queue 5-12

I
image color matching (Windows 95) 3-13
Info Status screen 1-4
Install Software option 1-8
Interleaved option D-3

J
Job Log

in Fiery XJ Spooler 5-22
printing 1-5

L
LaserWriter driver xiii
LaserWriter Printer Driver 2-1
light on Control Panel 1-2
Linear target 6-3
list of fonts, printing 1-5
lpq command 7-2
lpr command 7-2
lprm command 7-3

M
Macintosh

chooser C-2
system requirements xiii

Match Copy option 4-5
measured curve, viewing 6-22
measurements files 6-2, 6-16



I-3 Index
Media Type option D-3
Menu button 1-2
Microsoft PowerPoint

Macintosh 2-7
Windows 3-17

Microsoft Word
Macintosh 2-7
Windows 3-17

Mirror option 3-8
Monitor rendering style D-4
moving jobs in Fiery XJ Spooler 5-19

N
Negative Image option 3-8
NetWare, printing 3-2
Note 1/Note 2

in Fiery XJ Spooler 5-23
Macintosh 2-3
Windows 3-6

number of copies, specifiying D-2

O
on/off switch 1-7
Override Print Settings 5-20

P
PageNOW! paging software xiii, 5-25
Page Setup dialog box 2-2
PANTONE 1-5
PANTONE book files

Macintosh 2-7
Windows 3-17

paper sizes supported xvi
paper tray, bypass 2-4, 3-14
parallel port

printing with 3-1
problems C-6

password 5-24
Photographic rendering style D-4
Photoshop plug-in 4-1
PostScript options 3-3
PowerBook setup for calibration 6-6
PowerPoint

Macintosh 2-7
Windows 3-17

power switch 1-7
preferences 5-16
prescan 4-1
Presentation rendering style D-4
Printed queue 5-12
printer description files 2-2
printer driver

Macintosh 2-1
Windows 3.x 3-2
Windows 95 3-9
Windows NT 3-3

printer fonts 5-7
Printer’s Default setting 2-3, 3-5, 3-11
Printers dialog box, Windows 3-6
printer setup

with Adobe PostScript Printer Driver for 
Windows 3-3

with Windows PostScript Printer 
Driver 3-6

printing
from Fiery XJ Downloader 5-4
from Macintosh applications 2-1
from Windows applications 3-1
list of fonts 5-3, 5-11
with Novell NetWare 3-2
with Windows 3.x 3-2
with Windows 95 3-2
with Windows NT 3-3

Print Pages command 1-5
Print queue 5-12
Print Setup dialog box, Windows 3-7
Print Status screen 1-3
Print XJ Pages command 1-5
problems C-1
PSCRIPT.DRV 3-2, 3-6
PSCRIPT.DRV for Windows 95 3-9



I-4 Index
R
Reboot Server command 1-6
Rendering Style option D-4
Resampling option in Fiery XJ Scan 4-5
resolutions supported xvi
restarting the server 1-8
Resume Printing command 1-6
RGB01.DOC file 3-17
RGB02.PPT file 3-17
RGB Color Reference pages

Macintosh 2-7
Windows 3-17

RGB page 01/02 files 2-7
RGB_REF folder 3-17
RIP Status screen 1-4
Run Diagnostics 1-6
Run Setup 1-8

S
safety warnings xiii
scanning 4-1
Send Header with Each Job option 3-7
Sharpness option D-4
‘showpage’ after EPS files option 5-7
shutting down the server 1-9
Solid Color rendering style D-4
sorter D-4
Sorter Mode option D-4
spooler 5-12
starting the server 1-7
status, displaying C-1
status messages, Control Panel 1-3
Suspend Printing 1-6
SWOP-Coated target 6-3
system requirements

Macintosh xiii
Windows xiv

T
target curve, viewing and editing 6-22
target files

removing 6-21
understanding 6-2
using 6-19

TCP/IP (UNIX)
printing 7-1

TCP/IP (Windows NT) 3-3
Test Page, printing 1-5
Toolbar in Fiery XJ Downloader 5-3
transparencies 2-4, 3-14
Transparency option D-3
troubleshooting C-1
TrueType fonts 3-8
turning off the server 1-9

U
UNIX

printing 7-1
setting up printing 7-1

Use image color matching (slower) option in 
Windows 95 3-13

W
warnings xiii
Windows

system requirements xiv
Windows 3.x, PostScript printer driver 3-2
Windows 95 Printer Driver 3-9
Windows NT 3-3
World Wide Web (WWW) page xii

X
X-Rite DTP32 densitometer 6-4
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